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Bevezetés

K6szonjik, hogy a Medtronic Diabetes termékét valasztotta a cukorbetegség hatékonyabb
kezelése érdekében. Meggy&z6désiink, hogy a CareLink® Pro szoftver korszerlii megoldasait és
egyszerii, menulalapu felhasznaléi fellletét hasznosnak fogja taldlni.

A CareLink Pro haszndlataval a beteg terapids és diagnosztikai adatait gyUjtheti 6ssze,
tarolhatja és formalhatja jelentéssé. A szoftverrel ezenkivil a beteg altal a pumpaval, a mért
értékekkel és a szenzor altal mért glikdzértékekkel 6sszefliggésben a CarelLink® Personal
rendszerbe feltoltott adatokhoz is hozzaférhet. Ez a rendszer egy a CareLink Pro alkalmazassal
egylttm(kodd webes terdpiairanyitd felllet.

Jellemzok

A CareLink Pro egy személyi szamitdgépeken futtathatd szoftver a diabéteszterapia
irdnyitasara az alabbi szolgdltatasokkal:

«  Betegrekordok hozhatok létre a beteg késziilékébdl beolvasott adatok, valamint a beteg
Carelink Personal-fiokjabol beolvasott terdpiaadatok taroldsa céljabol.

« Az inzulinpumpaktol, a monitoroktdl és a vércukorméréktdl kapott adatok elkiildheték a

rendszernek, menthetdk, és jelentések készitéséhez is felhasznalhatok.

« A szoftver képes egyuttmikddni a CareLink Personal rendszerrel is, ezzel lehetévé téve a
beteg altal abban mentett készlilékadatok elérését. Mindez idedlis megoldas a beteg egyes
fellllvizsgalatai kozotti jelentések elkészitéséhez, igy nem feltétlenil van sziikség a
késziilékben tarolt adatok beolvasasara a vizsgdlatok soran.

« A betegnapléban tarolt készllékadatokbol kulonféle kezelési jelentések hozhatdk létre. Ezek
a jelentések segitenek megvalaszolni a beteg egyiuttmikodésével, a kezelési sémakkal és a
kivételekkel kapcsolatos kérdéseket.

« A rendszer értesitést jelenit meg, ha letdlthetd és telepitheté szoftverfrissitések valnak
elérhetévé. Ily mdédon biztosithatd, hogy mindig a legujabb funkcidkat lehessen hasznalni.
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« Az Uutmutatd segitségével a CarelLink Pro hasznalatdban még nem jartas felhasznalék is
konnyebben eligazodhatnak, mert megjegyzéseket és tippeket nyujt a végrehajtandé
feladatokhoz.

« A szoftver teljes egészében egy integrdlt sigérendszer nyujt informacioét a kilonbozd
terlletekrdl.
Biztonsag

« A CarelLink Pro jelszavas védelemmel lathato el.

« A beteg CareLink Personal feliiletrél szarmazé adatainak atvitele SSL-alapu titkositassal
torténik.
Kapcsolodo dokumentumok

A Medtronic MiniMed minden ilyen dokumentuma ebben a hasznalati Utmutatéban nem
részletezett késziilékinformdacioét tartalmaz.

MEGJEGYZES: A mds gydrtok méréeszkézeivel kapcsolatos tudnivalékat a gydrték dltal
mellékelt dokumentdcio tartalmazza.

« A Paradigm inzulinpumpa hasznalati Utmutatoja

« A Guardian REAL-Time monitor hasznalati utmutatdja
« A szenzorfunkciok haszndlati utmutatdja

« A ComLink haszndlati utmutatéja

« A CareLink USB hasznalati utmutatdja

Tamogatas

Ha tovabbi kérdései vannak a rendszerrel kapcsolatban, forduljon a helyi képviseletiinkhoz. A
nemzetkozi elérhetdségeket a kdvetkezd webhelyen olvashatja:

http://www.medtronicdiabetes.com/help/contact/locations.html

Tamogatott késziilékek

A CareLink Pro a kovetkezd késziilékektdl tud adatokat fogadni.

MEGJEGYZES: A szoftver dltal tdmogatott késziilékek némelyike nem feltétleniil érheté el
minden olyan orszdgban, ahol a szoftver haszndlatdt engedélyezték.
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Medtronic MiniMed pumpak

CSS-7100
CSS-7100K

o L +  Bayer CONTOUR® LINK
Medtronic Diabetes partnerkésziilékek . . i . o
. BD Paradigm Link® vércukorszintmérd

Guardian REAL-Time monitorok

. Ascensia BREEZE®
Bayer . BREEZE® 2
. CONTOUR®

. Ascensia® DEX®

. Ascensia® DEX® 2

. Ascensia® DEXTER-Z® Il
. Glucometer® DEXTER-Z®
. Ascensia® ESPRIT® 2

. Glucometer® ESPRIT®

. Glucometer® ESPRIT® 2

Bayer Ascensia® DEX® termékcsalad, koztik ezen
kompatibilis méréeszkozok

. FreeStyle®

. FreeStyle® Lite®

. FreeStyle® Freedom®

. FreeStyle® Freedom Lite®
. Precision Xtra™

Abbott . TheraSense FreeStyle®

. FreeStyle® Flash®

. FreeStyle® Papillon™ mini
. FreeStyle® Mini®

. Optium Xceed™

. Precision Xceed™
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A Medtronic MiniMed 508-as pumpdhoz. (A
Com-Station szlikséges hardverrél a Com-Station hasznalati
Utmutatoja nyujt részletes felvilagositast.)

A MiniMed Paradigm pumpahoz és a Guardian
REAL-Time monitorhoz. (A sziikséges hardverrél a
Paradigm Link® vércukorszint-monitor hasznalati
utmutatdja nyujt részletes felvilagositast.)

Kilsé gyartdk vércukorszintmérdihez. A gyartdk
sajat adatatviteli kabelt mellékelnek
késziilékeikhez.

Paradigm Link® vércukorszint-monitor

Megjegyzés: Ha egy méréeszkdz gyértdja soros
kabel helyett USB-kdbelt mellékel az adatok
atviteléhez valé hasznalatra, akkor telepiteni kell a
Adatatviteli kdbel gyartotdl kapott illesztéprogramot.

Emellett érdeklédje meg a méréeszkoz
gyartoéjanal, hogy az USB-illesztéprogram
kompatibilis-e az On altal hasznalt operécios
rendszerrel. Egyes USB-illesztéprogramoknak
nincs 64 bites operacios rendszeren hasznalhaté
verzidja.

Helyettesit6 késziilékek

A rendszer Ujabb késziilékkel torténd bévitésekor a tipust és a modellszamot egy listabdl
kell kivélasztania. Ha nem taldlja a széban forgé készilék tipusat és modellszamat a
listdban, az aldbbi tdblazatbdl kivalaszthatja a megfeleld helyettesité késziléket.

. Bayer Ascensia® DEX® 2

. Bayer Ascensia® DEXTER-Z® ||
. Bayer Glucometer® DEXTER-Z®
. Bayer Ascensia® ESPRIT® 2

. Bayer Glucometer® ESPRIT®

. Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Precision Xceed™ Optium Xceed™

Megrendelés

A Medtronic Diabetes termékeinek megrendeléséhez forduljon a helyi képviseletiinkh6z. A
nemzetkozi elérhetéségeket a kdvetkez6 cimen olvashatja:

http://www.medtronicdiabetes.com/help/contact/locations.html
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MEGJEGYZES: A méréeszkézoket azok gydrtéjdtél rendelheti meg.

Az Utmutato haszndlata

MEGJEGYZES: A haszndlati utmutatéban szoftverképernyé-mintdk is helyet kaptak. A
szoftver tényleges képernydinek tartalma némileg eltérhet a jelen dokumentumban
latottaktol.

A szoszedetben megtaldlja a kifejezések és a funkciok meghatarozasat. Az itmutatoban
hasznalt kifejezések jelentését a kovetkezd tablazat tartalmazza.

A képernyé objektumaira a bal egérgombbal

Kattintas kattintva kijelolheték az objektumok.

A képerny6 objektumaira a bal egérgombbal

BUIRE Ll it duplan kattintva megnyithatok az objektumok.

A képerny6 objektumaira a jobb egérgombbal

Kattintds a jobb gombbal kattintva masik ablak vagy meni jelenitheté meg.

Gombot, képernyénevet, mezénevet vagy
Félkovér szoveg menielemet jelol. Példaul: Patient > New Patient
(Beteg > Uj beteqg)

fc. Egy eljardshoz vagy lépéshez ad tovabbi
MEGJEGYZES: informaciot.

Veszélyre hivja fel a figyelmet, amely a szoftver
FIGYELEM! vagy a berendezés enyhe vagy kdzepes mértékii
karosodasat okozhatja.

Olyan lehetséges veszélyre hivja fel a figyelmet,
£ 1 amely haldlt vagy sulyos sériilést okozhat.

VIGYAZAT! Esetenként potencidlis szévédményekre vagy

biztonsagi szempontokra hivja fel a figyelmet.

A felhasznal6 biztonsaga

Alkalmazasi teriilet

A CareLink Pro rendszer célja, hogy a cukorbetegség kezeléséhez hatékony eszkozt
biztositson. Rendeltetése az, hogy fogadja az inzulinpumpdktdl, vércukorszintmérdktdl és a
vércukor szintjét folyamatosan figyel6 rendszerektél érkezé adatokat, és azokat CarelLink Pro-
alapu jelentésekké alakitsa. Ezekkel a jelentésekkel azonosithatdk a kialakult trendek, és
nyomon kovethetdk a napi tevékenységek (példaul az elfogyasztott szénhidratok, az étkezési
idépontok, az inzulin beadasdnak idépontjai és a vércukorszint leolvasdsanak idépontjai).

Figyelmeztetések
« A rendszert csak a cukorbetegség kezelésének médjat ismeré szakorvos hasznalhatja.

« A rendszer éltal adott eredmények nem képezhetik orvosi tanacsadas alapjat.
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A terméket kizarolag a jelen dokumentumban felsorolt tamogatott késziilékekkel szabad

hasznélni. (Tovébbi informaciét a kdvetkezé helyen taldl: Tdmogatott késziilékek 2. oldal.)

Javasolt, hogy a beteg naponta legaldbb 4-6 alkalommal ellenérizze vércukorszintjét.

Szakorvosi egyeztetés nélkul a betegnek nem szabad moédositania a kezelés modjat.

A betegnek nem a vércukorszintszenzor eredményei, hanem a szakorvos irdnymutatasa és a

vércukorszint mért értékei alapjan kell dontenie a kezelés mikéntjérdl.

Ellenjavallatok

A szoftvert csak a vonatkozd tablazatban emlitett készilékekkel szabad hasznalni (tovabbi

informacié: Tdmogatott késziilékek 2. oldal). A termék csak a cukorbetegség kezelésére szolgal.

A szoftver inditasa el6tt zarja be a szamitdgépen jelenleg mikodd kdvetkezé szoftvereket:

CGMS® System Solutions™ szoftver (7310)
Solutions” Pumps & Meters szoftver (7311)
Guardian® Solutions” szoftver (7315)
ParadigmPAL™ (7330)

CareLink® Personal szoftver (7333)

Solutions® szoftver a CGMS’iPro termékhez (7319)

CareLink Pro Hasznalati utmutatd
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Elso lépések

Az aldbbiak a Carelink Pro szoftver elinditasat, a betegek rekordjainak megnyitasat és
bezdardsat, valamint a rendszer minden betegére érvényes bedllitdsok megaddsat mutatjak be.

Miel6tt hozzdkezdene...

Ha most hasznalja elészor a CareLink Pro szoftvert, mindenképpen adja meg az altalanos
beallitasokat (lasd: Altaldnos bedllitdsok 12. oldal). Ezek a beallitasok hatarozzak meg, hogy
bizonyos elemek hogyan jelenjenek meg a szoftverben és a jelentésekben, és ezek

Ezeket a beallitdsokat barmikor elvégezheti, ezért érdemes a tobbi beallitds megadasa eldtt
megismerkedni a CarelLink Pro szoftverrel.

Elsédleges rendszerfeladatok

Az aldbbi tablazat ismerteti a CarelLink Pro elsé bedllitdsa és haszndlata soran elvégzendé fébb
feladatokat. A tablazatbdl az is kideril, hogy a hasznalati tmutaté melyik része foglalkozik az
adott feladattal.

Ismerkedés a CareLink Pro felhasznaldi fellletével Navigdlds a rendszerben 8. oldal

Az On rendeléje altal hasznalt globalis

rendszerbesllitasok megadasa Rendszerbedllitdsok megaddsa 11. oldal

Profil l1étrehozésa minden beteg szamara Uj profilok hozzdaddsa 20. oldal

Kapcsolodas a betegek Carelink Personal-fikjaihoz ’;‘;p ;73;7“5 & Ll e SEe e

Pumpadk és méréeszk6zok hozzdaddasa a beteg

o Készlilék hozzdaddsa 28. oldal
profiljahoz

Adatok beolvasadsa a beteghez tartozé pumpakroél és

Y I Késziilék adatainak beolvasdsa 34. oldal
mérdeszkozokrol

Jelentések beallitasa és elkészitése az egyes betegekrdl | Jelentések létrehozdsa 38. oldal
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Rendszeres biztonsdgi masolat készitése a CarelLink Pro
adatbazisarol

Az adatbdzis biztonsdgi mentése 49. oldal

A CareLink Pro szoftver frissitése

Szoftverfrissitések alkalmazdsa 48. oldal

Navigalas a rendszerben

Miel6tt megkezdené a Carelink Pro hasznalatat, érdemes megismerkednie az alkalmazas

felhasznaloi felliletével. A felhasznaloi felllet a menikbdl, egy eszkdztérbdl, egy navigacios

savbol, munkateriiletekbdl és egy utmutatd ablakbol épil fel.

A CareLink Pro megnyitasa

1 Kattintson dupldn a szdmitégép asztalan talalhaté Carelink Pro ikonra ﬂ, vagy kattintson a
F =

Windows Start menl Programok csoportjan belil megtaldlhaté Medtronic CareLink Pro

parancsra.

Ha a rendel6i rendszer jelszd beirasat kéri, megjelenik a bejelentkezési képernyd.

a. irja be a jelszét a Password (Jelsz6) mezébe.

MEGJEGYZES: A jelszavas védelem a telepitési folyamat sordn dllithaté be

vdlaszthato lehetéségként.

b. Kattintson a LOGIN (Bejelentkezés) gombra.

Megjelenik az inditoképernyé.

2 A New Patient (Uj beteg) ikonra kattintva Uj betegrekordot vehet fel, az Open Patient

(Betegadatok megnyitasa) ikonnal pedig megnyithatja a sziikséges betegrekordot a betegek

rendszerbeli listajarol.

Munkateriiletek

Ha meg van nyitva egy betegrekord, a navigacios sav valamelyik gombjara kattintva

megjelenithetd a kapcsolodé munkaterilet. A felsorolt munkateriiletekkel irhatok be vagy

valaszthatok ki a beteghez k6t6dd Carelink Pro-feladatok végrehajtdsahoz sziikséges adatok.

Profile (Profil): A betegadatok (példaul név
és sziletési datum) térolasara szolgal, és
lehetévé teszi a beteg CarelLink Personal-
fiékjahoz vald csatlakozast is.

Devices (Késziilékek): A beteg késziilékeinek
olvasasahoz sziikséges adatok taroldsara
szolgal.

[=]|e) 3]

Reports (Jelentések): Lehet6vé teszi a
paraméterek kivalasztasat, valamint a
beteghez létrehozandé jelentések megadasat.
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Amig nem vesz fel és nem ment egy profilt a széban forgd beteghez, csak a Profile
munkaterilet hasznalhaté. Csak a Profile és a Devices munkaterilet érheté el, amig nem ad
hozzd a beteghez készilékeket.

Eszkoztar

A CareLink Pro eszkoztara lehetévé teszi a gyakran hasznalt funkcidk gyors elérését. Az
eszkodztar az alabbi gombokat tartalmazza.

Megnyitja a Profile
% Add Patient (Beteg hozzdadasa) Lneﬁzgiéigﬂftfghzgegfg Y
rendszerbe.

Megnyitja a Patient Lookup
(Beteg keresése) tablazatot,
amelyben kivéalaszthatok
megtekintésre a mar meglévé
betegrekordok.

q Open Patient (Beteg adatainak
—_— megnyitasa)

Megjeleniti vagy elrejti az

. . . Utmutatét. Erre a gombra
_? Guide Me (Utmutato) kattintva kornyezetfliggd sugo
jelenitheté meg.
Betegrekordlapok

Egy adott betegrekord megnyitdsat kovetéen egy a beteg nevét feltiintetd lapfiil jelenik meg
az eszkoztar mentén. Ha egy lap aktiv, akkor a kapcsolddd betegrekord és munkaterilet is
aktiv, és végrehajthatdk a beteggel 6sszefliggé CareLink Pro-feladatok.

=& Medtronic Carelink® Pro

Fi|E__"."iE!.-\.' Tupls Language Help | @ q ?
Mew Patient [

Egy betegrekord aktivaldsdhoz kattintson a beteghez tartozé filre. Betegrekord bezarasdhoz
kattintson a fulon lathaté Close (Bezaras) gombra E.

Az Utmutato

A Carelink Pro szoftver teljes egészében segitségul hivhaté az utmutato, amelynek ablakdban
kornyezetfliggd megjegyzések és tippek taldlhatok az aktiv rendszerésszetevd hasznélatdhoz.
Az Utmutatd ablakdban esetenként >> learn more (tovabbi tudnivaldk) szovegd, tovabbi
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informacidra utalé hivatkozasok is lathatok. E hivatkozasokra kattintva az online sigé bévebb
tdjékoztatast tartalmazd megfeleld része nyilik meg. Az utmutatd alapértelmezés szerint

engedélyezett, de barmikor ki is kapcsolhaté.

u

Start up window

IF you choose bo add & new patient, a

blank Frofie warkspace is daplayed. IF
you choose ko open an exisking patis:
recoed, the Open Pabent window is

displayzd,

#¥ lmarmn mare

What next? B |
T wou ae adding 4 new patienc, woo wil
complece el prafile.

¥ learn rore

IF you &e opening 2n exicting patisn,
You Can: e

Az utmutato be- és kikapcsolasa

Az Utmutatot a kovetkezé modszerekkel kapcsolhatja be vagy ki:
- Kattintson a Guide Me (Utmutat6) gombra. 3

- Kattintson a Help > Guide Me (Sugé > Utmutatd) parancsra.

A betegek rekordjainak megnyitasa

Osszesen hat betegrekord lehet nyitva egyszerre. Ha még nem hozott létre profilokat,

olvassa el ezt a részt: Uj profilok hozzdaddsa 20. oldal.

1 Valassza a File > Open Patient (F3jl > Beteg adatainak megnyitdsa) parancsot, vagy

kattintson az Open Patient gombra &, . Az alabbihoz hasonl6 beteglista jelenik meg.

“& Open Patient

Find a Patient |[ oEar s
| Date of
| Firsk: Mame Last Name Birth Patient I

SEMFLE PATENT 12071975 I

Senpk PtierkZ 1L1{L963 100001

Sanpk Pstierkd TE9T 100002

MEW PATIENT | IPEM CANCEL
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MEGJEGYZES: Ha az az iizenet jelenik meg, hogy tiil sok rekord van nyitva, a
folytatds elétt kattintson az OK gombra, majd zdrjon be egy rekordot.

2 A beteg nevének vagy neve egy részének beirdsaval keresse meg a beteget a Find a Patient
(Beteg keresése) mezében. Ha a beteghez tartozé sor ki van jeldlve, kattintson az OPEN
(Megnyitas) gombra, kattintson dupldn a lista kijel6lt sorara, vagy nyomja le az ENTER
billentyt. A billenty(izet FEL és LE nyilbillenty(ivel is Iépkedhet a lista elemei kozott.

Ekkor a beteghez tartoz6 Devices (Készilékek) munkaterilet (ha nem allitott még be
késziiléket) vagy Reports (Jelentések) munkateriilet jelenik meg.

3 A beteghez tartozé Profile (Profil) munkateriilet megjelenitéséhez kattintson a Profile

gombra @ .

PR |

A betegek rekordjainak bezarasa

1 Gyd6z8djon meg arrdl, hogy a bezarni kivant rekord aktiv (a lap ki van jel6lve).

2 A kovetkezd lehetdségek kozil valaszthat:
a. Valassza a File > Close Patient (F3jl > Betegadatok bezarasa) parancsot.
b. A beteghez tartozo fulon kattintson a Close (Bezaras) gombra E3.
c. Nyomja meg a Ctrl+F4 billenty(ikombinaciot.

Rendszerbeallitasok megadasa

Ezek a bedllitdsok a rendszerben szereplé minden betegre vonatkoznak. A csak bizonyos
betegeket érintd beallitdsokrol a kovetkezd helyen talal tudnivaldkat: Jelentés bedllitdsainak
ellenérzése 41. oldal.

A beadllitasok az aldbbi csoportositasban jelennek meg:

«  General (Altalanos)
- Glucose units (Vércukor mértékegysége)
- Carbohydrate units (Szénhidrat mértékegysége)
- Communications (Kommunikacio)
- Troubleshooting (Hibaelharitas)

«  Patient Profile (Betegprofil)
- A betegek profiljain szereplé adatok kivalasztasa és szerkesztése

«  Patient Lookup (Beteg keresése)
- Az Open Patient parancs nyoman megjelend beteglistan szereplé mezék sorrendjének
modositasa
+  Report Generation (Jelentés készitése)
- Az adattabla adatai alapjan a Daily Detail (Részletes napi) jelentésben megjeleniteni
kivant adatok
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Altalanos beallitasok

A General (Altalanos) lapon azt adhatja meg, hogy a szoftver milyen formaban jelenitsen

meg bizonyos tipusu adatokat, valamint az adatatviteli beallitdsokat is itt valaszthatja ki.

1 Kattintson a General (Altalanos) fiilre, ha nem ez a lap van megjelenitve.

2 Valassza a Tools > Options (Eszkdzok > Beallitdsok) parancsot. Megjelenik az alabbi ablak.
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3 A vdlasztégomb segitségével jeldlje ki a kivant értéket:

- Glucose Units (Glik6éz mértékegysége): mg/dl vagy mmol/I

- Carbohydrate Units (Szénhidrat mértékegysége): grams (gramm) vagy Exchanges

(Csereegyséqg)

a. Ha a Carbohydrate Units bedllitdshoz az Exchanges értéket vélasztotta, irja be a

megfelel6 szamot a grams are equal to 1 Exchange (gramm egyenl6 egy

csereegységgel) mezébe.

4 Kattintassal jeldlje be a Chart Options > Overview Report (Diagrambeallitasok, Osszefoglalé

jelentés) csoport jelolénégyzetét, vagy torolje annak jelolését. Ha a jel6lénégyzet be van

jelolve, az alkalmazdas a mért vércukorszinteket vonalakkal koti 6ssze a méré vércukorszint-

feddgrafikonjan. (Ez a szenzor- és mérdadatok 6sszefoglald jelentésében megjelend grafikon.)

5 Jelolje be a Communications csoport aldbbi jelolédnégyzeteit az engedélyezéshez, vagy

tordlje azok jelolését a tiltashoz:

MEGJEGYZES: A kommunikdciéval kapcsolatos bedllitdsok elvégzése sordn vegye

figyelembe a rendel6 vagy az intézmény informatikai részlegének irdnyelveit.
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- Automatically check for software updates (Szoftverfrissitések automatikus
keresése): Engedélyezése esetén minden Carelink Pro szoftvert futtatd rendszer
értesitést kap, ha van elérheté szoftverfrissités. Ekkor az aktiv felhasznaldk letolthetik és
telepithetik a frissitéseket. A szolgaltatas kikapcsolasahoz és a szoftverfrissitések
telepitésének kozvetlen irdnyitasdhoz tordlje a jeldlést a jelolénégyzetbdl.

- Synchronize with Medtronic CareLink® Personal (Szinkronizalas a Medtronic
CareLink® Personal szoftverrel): Akkor jellje be ezt a jelolénégyzetet, ha azt szeretné,
hogy a rendszer automatikusan szinkronizélja a betegek CareLink Personal rendszerbeli
adatait minden alkalommal, amikor megnyitja a profiljukat. Ha torli a jel6lést, kézzel kell
majd szinkronizalnia minden egyes beteg adatait a CareLink Personal adataival.

6 Kattintassal jeldlje be a Troubleshooting csoport jeloldnégyzetét, vagy tordlje annak
jelolését. Ha a jelolénégyzet be van jel6lve, az alkalmazas a késziilékadatok minden
beolvasasakor hibaelharitas céljabol menteni fog egy adatrekordot.

7 Az altalanos bedllitdisok mentéséhez kattintson az OK gombra.

A betegprofilok beallitasai

Ez a profilok tartalmat meghatarozo globalis beallitas. A Profiles munkateriilet mezdit igényei
szerint beallithatja arra, hogy azok a rendeldje szamara legfontosabb adatokat jelenitsék meg.
Felvehet Uj mezdbket, eltdvolithatja a meglévdket, |étrehozhat sajat egyéni mezdket, és
meghatérozhatja a mezdknek az ablakban elfoglalt sorrendjét.

1 Valassza a Tools > Options (Eszkdzok > Bedllitdsok) parancsot.

2 Kattintson a Patient Profile fiilre. Megjelenik az alabbi ablak.
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MEGJEGYZES: A jelolénégyzetek segitségével adja meg a profilon megjeleniteni kivdnt
mezdket. A felfelé és lefelé mutaté nyilak segitségével rendezze sorba a mezéket.
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Az adatmez6k kivalasztasa

1 A kivant mezbket a jelolénégyzetek segitségével adhatja hozza.

MEGJEGYZES: A First name és a Last Name mezét nem lehet eltdvolitani.

2 Egy mez6 eltavolitdsahoz torolje a jeldlést a mezd melletti jelolénégyzetbdl.

3 Egy mezb kotelezb felvételéhez jeldlje be a Required (Kotelezd) oszlopban taldlhato
jelolénégyzetet. Az 6sszes kotelezd mez6t ki kell tolteni a profil létrehozdsahoz.

Egyéni mez6 hozzdadasa

1 Jel6lje be valamelyik Ures egyéni mezd bal oldalan taldlhaté jel6lénégyzetet.

2 Nevezze el a mezét (pl. Vészhelyzeti elérhetéségek). A mezb ezzel a névvel szerepel majd a
beteg profiljan.

3 A mezd kotelezdvé tételéhez jeldlje be a Required oszlopban talalhaté jelolénégyzetet.

MEGJEGYZES: Egyéni mezé eltdvolitdsdhoz térélje a jelet az adott mezé
jelolénégyzetébadl.

Az adatmezo6k sorrendjének megvaltoztatasa

Jelolje ki az athelyezni kivant mez6t, majd a felfelé és lefelé mutatd nyilak : ; segitségével
mozgassa azt. (A legfelsé és a legalsé nyil a lista tetejére, illetve aljara helyezi at az adott
mezd4t.)

A betegprofil beallitdsainak véglegesitése

Ha a Field Order (Mez8sorrend) listan az egyes mezd&k a kivant sorrendben szerepelnek,
kattintson az OK gombra.

A betegprofilok ekkor az On altal megadott mezékkel és mezésorrenddel rendelkeznek.

A betegkeresés bedllitasai

A Patient Lookup tablazat hasznalatdval megkereshet és megnyithat egy betegrekordot. A
tablazat az adatbazisban |étez6 6sszes beteget és az ezek profiljdban szereplé azonosité
adatokat tartalmazza. Sajat igényeinek megfeleléen megvaltoztathatja, hogy a tablazatban mely
adatok milyen oszlopsorrendben jelenjenek meg. A Patient Lookup tablazat testreszabasahoz
tegye a kovetkezdket:

1 Valassza a Tools > Options (Eszkozok > Beallitasok) parancsot.
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2 Kattintson a Patient Lookup fiilre. Megjelenik az aldbbi ablak.

L Opliens
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MEGJEGYZES: A jelolénégyzetek segitségével adja meg a Patient Lookup tdbldzatban
megjeleniteni kivdnt adatokat. A felfelé és lefelé mutaté nyilak segitségével rendezze
sorba az oszlopokat.

A megjeleniteni kivant adatok kivalasztasa

A jeloldnégyzetek segitségével adja meg, hogy mely adatok jelenjenek meg a Patient Lookup
tablazatban.

Az oszlopok sorrendjének megvaltoztatasa

A Patient Lookup tablazat oszlopsorrendjének megvaltoztatasahoz jeldlje ki az athelyezni
kivant oszlopot, majd a fel- és lefelé mutatd nyilakkal : ; mozgassa azt. (A legfelsé és a
legalsé nyil a lista tetejére, illetve aljara helyezi at az adott adatoszlopot.)

A Column Display Order (Oszlopok megjelenitési sorrendje) csoport legfelsé adatoszlopa lesz
a Patient Lookup (Beteg keresése) tablazat elsé oszlopa. Az alsé adatoszlop lesz a tablazat
utolsé oszlopa.

A betegkeresés beallitasainak véglegesitése

Ha a Column Display Order listaban az egyes adatok a kivant sorrendben szerepelnek,
kattintson az OK gombra.

A Patient Lookup tablazat ekkor az On altal megadott adatokkal és oszlopsorrenddel
rendelkezik.
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A jelentéskészitéssel kapcsolatos bedllitasok

Az adattabla a Select and Generate Reports (Jelentések kivalasztasa és létrehozdsa) ablakban
jelenik meg, és a jelentéskészitésben jatszik szerepet. A tabla a beteg késziilékeibdl,
valamint adott esetben a beteg CareLink Personal-fiékjabdl beolvasott napi adatokat
tartalmazza, melyekbdl megallapithatd, hogy mely napokra vonatkozéan sziikséges
létrehozni napi részletes jelentést. A tabla segitségével azt is megallapithatja, hogy a tobbi
jelentés kozll melyeket kell futtatnia.

Rendeldje sajat igényei szerint allithatja be, hogy mely adatok és milyen sorrendben

jelenjenek meg ebben a tablaban.

MEGJEGYZES: Azzal kapcsolatban, hogy ezek a bedllitdsok hogyan lesznek az adattdbldra
alkalmazva jelentéskészitéskor, a kovetkezé helyen taldl informdciot: Jelentéstipusok és
felvenni kivdnt ddtumok kivdlasztdsa 43. oldal.

1 Valassza a Tools > Options (Eszkozok > Beallitasok) parancsot.

2 Kattintson a Report Generation (Jelentés készitése) fiilre. Megjelenik az alabbi ablak.
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A megjeleniteni kivant adatok kivalasztasa

A jelolénégyzetek segitségével adja meg az adattablaba felvenni és az abbdl eltavolitani

kivant adattipusokat.

Az adattablaba az alabbi adatokat veheti fel.
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Ne of Meter Readings (Mérések szama

A megadott napon a megadott késziilékek altal
rogzitett mérések szédma.

Sensor Duration (Szenzor rogzitési idétartama)

Highest Reading (Legnagyobb érték)

A megadott napon bellli azon idétartam, amely
alatt a szenzor adatokat rogzitett. Lehetséges
értékek: (nincs), 0:05 - 24:00.

A megadott napon (szenzor vagy méréeszkoz altal)
rogzitett legmagasabb vércukorszint.

Avg AUC Below Target (Atlagos AUC a céltartomany
alatt)

Total Carbs (Osszes szénhidrat)

A beteg céltartoménya ald esé atlagos AUC (gorbe
alatti tertlet).

Azoknak a szénhidratmennyiségeknek (a
legkozelebbi grammértékre vagy 0,1 csereegységre
kerekitett) 6sszege, melyeket az adott nap folyaman
Bolus Wizard-események, illetve a pumpdan vagy a
Guardian késziiléken [évé szénhidratmarkerek

Ne of Rewinds (Visszatekerések szama

jelentettek.

A visszatekerési események szdma a megadott
napon.

Prime/Fill Volume (U) (Feltoltési vagy toltési térfogat
(E)

Total Basal (U) (Osszes bézis (E))

Az adott nap feltoltési (vagy toltési) eseményeinél
hasznalt inzulin teljes mennyisége.

Az adott napon beadott bazisinzulin teljes
mennyisége (azaz a teljes beadott inzulinmennyiség
minusz a teljes beadott bolusmennyiség).

Basal % (Bazis %)

A bazisinzulin teljes inzulinmennyiséghez mért
szazalékos aranya (egész szdzalékokban).

N¢ of Boluses (Bolusok szama)

Bolus Wizard Overrides (Bolus Wizard felllbiralasai)

Az adott napon rogzitett bolusesemények szama.

Azoknak a Bolus Wizard-eseményeknek a szama,
amelyek sordn a beadott inzulin mennyisége eltér a
javasolt mennyiségtdl.
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Azoknak az adott napon rogzitett Bolus Wizard-
N2 of Correction Boluses (Korrekciés bolusok szama) eseményeknek a szdma, amelyeknél nullanal
nagyobb korrekcidos mennyiségek voltak régzitve.

A Bolus Wizard-eseményeken kiviili bolusesemények

Ne of Manual Boluses (Kézi bolusok szama) .
szama az adott napon.

Az oszlopok sorrendjének megvaltoztatasa
Az adattabla oszlopsorrendjének megvaltoztatasahoz jeldlje ki az athelyezni kivant oszlopot,

majd a fel- és lefelé mutaté nyilakkal : ; mozgassa azt. (A legfelsé és a legalsé nyil a lista

tetejére, illetve aljara helyezi at az adott oszlopot.)

MEGJEGYZES: A Column Order (Oszlopok sorrendje) lista legfelsé eleme lesz az adattdbla
elsé oszlopa. Az als6 elem lesz a tdabla utolso oszlopa.

A jelentéskészitéssel kapcsolatos beallitasok véglegesitése

Ha a Column Order listaban az egyes adatok a kivant sorrendben szerepelnek, kattintson az
OK gombra.

Az adattabla ekkor az On &ltal megadott adatokkal és oszlopsorrenddel rendelkezik.
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A Profile (Profil) munkateriilet

A profil az orvosok altal hasznalt kérlap feddlapjahoz hasonlit, és a beteg adatait (példaul a
nevét és a szliletési datumat) tarolja. A profil sziikséges a késziilék adatainak 6sszegy(jtéséhez
és a terapids jelentések elkészitéséhez.

eanio, e O I

e

Pabient Profille 55 e el
| —
* First Mame L0000
——l # Last Mamwe
;ﬂ_ Date of Birth ||
r—, — o
Devices Patient D
B}
Peolile

¥ daleiy patand o
muﬂnmmmm B3 b wues

Sabuss Nk inded

| L 0 exrsTiG Accoust |

l SEND E-MAIL INVTTATDON TO PATIENT

A Profile munkaterilet arra is alkalmas, hogy segitségével kapcsolédjon a beteg CareLink
Personal-fidkjdhoz. Amint a kapcsolat |étrejott, a beteg CarelLink Personal altal tarolt adataihoz
a beteg személyes jelenléte nélkil is barmikor hozza lehet férni.

Miel6tt hozzdkezdene...

A betegprofilok testreszabhaték annak érdekében, hogy csak az On éltal igényelt
informacidkat tartalmazzak. Tovabbi informacidkat a kovetkezé helyen taldl: A betegprofilok
bedllitdsai 13. oldal.
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Ha létre kivanja hozni a kapcsolatot a beteg CareLink Personal-fidkjaval, sziikség van

felhasznalénévre és jelszéra is. Ezen adatok megadasa a beteg személyes jelenléte mellett

torténik.

Uj profilok hozzaadasa

Minden egyes beteg CareLink Pro rendszerbe torténé felvétele el6tt ki kell tolteni egy profilt.

1

Vélassza a File > New Patient (Fajl > Uj beteg) parancsot, vagy kattintson az Add Patient

(Beteg hozzaadasa) gombra. g

Megjelenik a Profile munkaterulet.

MEGJEGYZES: Mezék hozzdaddsdhoz vagy médositdsdhoz a beteg profiljdn kattintson
a customize fields (mez6k testreszabdsa) feliratra. Ldsd: A betegprofilok bedllitdsai
13. oldal.

Toltse ki a Patient Profile (Betegprofil) csoportban taldlhaté mezdket.
Kattintson a SAVE (Mentés) gombira.

A program hozzaadja az Uj betegprofilt a CareLink Pro adatbazisdahoz, és egy megerdésité
Uzenet jelzi, hogy a profil mentése megtortént.

A kotelez6 mezok kitoltése

1

2
3
4

Ha egy kotelez6 mezd nincs kitdltve a betegprofil mentésekor, egy lizenet jelenik meg a
kitoltendé mez6é mellett. A profil mentése csak akkor lehetséges, ha a mezé ki van toltve.

Toltse ki a mezét.
Kattintson a SAVE (Mentés) gombra.

A megerdsité lizenet megjelenésekor kattintson az OK gombra.

Betegprofilok szerkesztése

A W N

Gy6z6djon meg arrdl, hogy az adott beteghez tartozé Profile munkateriilet meg van nyitva.
Kattintson az EDIT (Szerkesztés) gombra.

Szlikség szerint modositsa a Patient Profile szakasz adatait.

Kattintson a SAVE (Mentés) gombra.

Egy megerdsité lGizenet jelzi, hogy a profil mentése megtortént.

A beteg adatainak torlése a rendszerbdl

1

Gy6z6djon meg arrdl, hogy az adott beteghez tartozé Profile munkaterlilet meg van nyitva.

CareLink Pro Hasznalati utmutaté A Profile (Profil) munkatertilet 20



2 Ellendrizze, hogy valéban a tordlni kivant beteg adatai szerepelnek-e képernyén. A
betegprofil torlésével a beteg 6sszes adata visszavonhatatlanul torlédik a CareLink Pro
adatbazisabdl is.

3 Kattintson a profil szinkronizalasi szakasza feletti >> delete patient record (betegrekord
torlése) elemre.

Figyelmeztetd Uzenet jelzi, hogy a rekord torlésekor a beteg minden adata torlédni fog.

4 A beteg rekordjanak torléséhez kattintson a Yes (Igen) gombra.

Kapcsolddas a CarelLink Personal szoftverhez

A beteg beleegyezésével kapcsolatot hozhat létre a beteg CareLink Personal-fidkjaval. Ennek a
webalapu eszkdznek a segitségével a betegek feltolthetik és tarolhatjak a késziilékbél nyert
adatokat, valamint kilénb6z6 terapias jelentéseket futtathatnak.

Ha kapcsoldédik a beteg CarelLink Personal-fiokjdhoz, hozzdférhet az ott tarolt
késziilékadatokhoz. igy lehetésége van CarelLink Pro-jelentések készitésére a terapiardl két
vizsgdlat kozott, valamint kevesebbszer kell leolvasnia a késziiléket a beteg latogatasai soran.

Ha a betegnek még nincs CareLink Personal-fidkja, kildhet neki meghivé e-mailt, melynek
segitségével a beteg létrehozhatja sajat fiokjat.

Kapcsolat Iétrehozasa meglévo fidkkal

MEGJEGYZES: E lépésekhez a beteg személyes jelenléte sziikséges.

1 Ellendrizze az internetcsatlakozast.
2 Nyissa meg a beteghez tartozé Profile munkateriletet.

3  Gy6zédjon meg arrél, hogy minden sziikséges mezé ki van toltve a Patient Profile

csoportban.
4 Kattintson a LINK TO EXISTING ACCOUNT (Kapcsolédas meglévé fiokhoz) parancsra.
Megjelenik a CareLink Personal bejelentkezési képernydje.

5 Kérje meg a beteget az aldbbiakra:
a. irja be a felhasznalonevét és a jelszavat.
b. Kattintson a Sign In (Bejelentkezés) gombra.

Megjelenik a beteg terlileti és nyelvi bedllitdsait alapul vevé Grant Access (Hozzaférés

engedélyezése) képernyé.

6 Kérje meg a beteget az aldbbiakra:
a. Olvassa el a felhasznalasi feltételeket (Terms of Use).
b. Jeldlje be az | agree to the Terms of Use above... (Elfogadom a fent ismertetett
felhaszndlasi feltételeket) jelolénégyzetet.
c. Kattintson a Grant Access (Hozzéférés engedélyezése) gombra.
d. Jelezze, ha a Thank You (K6szonom) képernyé megjelenik.
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7 A felhasznalasi feltételeket ki is nyomtathatja a beteg szdmara, ha a Print (Nyomtatas)
gombra kattint. Ezzel sikeresen kapcsolédott a beteg CarelLink Personal-fidkjahoz.

E-mail meghivé kiildése

Ha meghivé e-mailt kivan kildeni a betegnek CarelLink Personal-fidk Iétrehozasa céljabdl,
végezze el a kdvetkezd |épéseket:

1 Nyissa meg a beteghez tartoz6 Profile munkateriletet.

2 Gy6z6djon meg arrél, hogy minden sziikséges mezd ki van toltve a Patient Profile

csoportban.

3 Kattintson a SEND E-MAIL INVITATION TO PATIENT (Meghivd e-mail kiildése a betegnek)

gombra.

S8 E-Masl Invwitation

W

(=0 ] [cance |

4 Gy6z6djon meg arrdl, hogy a Patient Name (Beteg neve), az Email Address (E-mail cim) és a

Language (Nyelv) mez6 helyesen van kitoltve.
5 Kattintson a SEND (Kuldés) gombra.

A betegprofil allapotteriiletén a program megerdsiti, hogy az e-mail elkiildése megtortént.

Adatok beolvasasa kapcsolattal rendelkez6 fiokbol

Ha kapcsolata van egy beteg Carelink Personal-fidkjaval, a rendszer automatikusan elkdldi a
fiokban 1évé Uj adatokat a betegprofil CareLink Pro alkalmazasban torténé minden

megnyitasakor.

MEGJEGYZES: Hogy ez biztosan megtérténjen, gy6z6djén meg arrél, hogy a Tools >
Options > General (Eszkézék > Bedllitdsok > Altaldnos) lapon be van jelélve a
Synchronize with Carelink Personal (Szinkronizdlds a CarelLink Personal szoftverrel)

jelolonégyzet.
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Azt, hogy a profil minden megnyitasakor megtorténjen a beteg CareLink Personal éltal kezelt

adatainak beolvasasa, a kovetkez6képpen allithatja be:

1

Gy6z6djon meg arrdl, hogy a beteghez tartozé Profile munkateriilet meg van nyitva, és
ellendrizze az internetcsatlakozast.

Valassza a Tools > Synchronize Patient Data (Eszk6zok > Beteg adatainak szinkronizalasa)

parancsot.

A szinkronizalas ikonja (g forogni kezd a beteg lapjan. Amikor az ikon megall, a folyamat

véget ért.

MEGJEGYZES: Ha a beteg nem kivdnja a tovdbbiakban megosztani a CareLink

Personal rendszerbeli adatait, errél egy iizenet jelenik meg.

A CareLink Personal éltal kezelt tovabbi adatok szerepelni fognak a betegrdl sz6lé

jelentésekben.

A beteg CareLink Personal-fidkja és a CareLink Pro kozotti kapcsolat
megsziintetése

A beteg Carelink Personal-fiokja és a CarelLink Pro kozotti kapcsolatot megsziintetheti. Ez a

lehet6ség csak akkor érheté el, ha korabban a kapcsolatot Iétrehozta. A kapcsolat

megsziintetésével megel6ézhetd, hogy a CarelLink Pro tovabbra is adatokat kérdezzen le a beteg

CarelLink Personal-fidkjabdl, ugyanakkor az eljards nem érinti a beteg sajat CareLink Personal-

fiokjaval kapcsolatos egyéb miveleteit.

1
2
3

Nyissa meg a beteg rekordjat, és véltson a Profile munkateriletre.
Kattintson az UNLINK ACCOUNT (Fiok kapcsolatanak megsziintetése) gombra.

A megerdsité Gizenet megjelenésekor kattintson a Yes gombra. A beteg profiljanak
kapcsolata megsziint a CareLink Pro szoftverrel.

Az dllapot Not linked (Nincs kapcsolat) értékre valt, valamint a LINK TO EXISTING ACCOUNT
és a SEND E-MAIL INVITATION TO PATIENT gomb ismét megjelenik.
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A hardver beallitasa

A kozvetlen adatbeolvasashoz sziikség van a beteg késziilékére, valamint a késziilék adatainak
a szamitégépre valé tovabbitasahoz sziikséges kabelekre és egyéb kommunikacids
eszkozokre.

Ha a beteg feltoltotte a késziilékeibdl szarmazd adatokat CarelLink Personal-fidkjaba, akkor az
adatok ehhez a fiokhoz kapcsolddva is lekérheték. A beteg Carelink Personal-fidkjdhoz val6
kapcsolodds 1épéseit a kdvetkezé rész ismerteti: Kapcsolddds a Carelink Personal szoftverhez
21. oldal.

A késziilékek csatlakoztatasa

Az attekintd abra altaldnos képet ad arrél, hogy a késziilékeket hogyan kell a szamitégéphez
csatlakoztatni a kommunikacio létrehozdsahoz. A tovabbi abrak a késziilékek
kommunikacidjanak egyedi jellemzdit ismertetik.

Részletesebb informaciokért kovesse a CarelLink Pro altal a készilék beolvasasakor
megjelenitett utasitasokat.
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A hardverbeallitas attekintése

Ezen az 4bran példaul lathatd, hogy a pumpa és a szamitdégép kézotti kommunikacioé a

CareLink USB segitségével torténik.

Példa soros és USB-kabellel torténé csatlakoztatasra:
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Opcionalis ComLink a Paradigm pumpdakhoz:

Opcionalis Com-Station a Medtronic MiniMed 508 pumpahoz:
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5

A Devices (Készuilékek) munkateriilet

A beteg késziilékének beolvasasahoz sziikséges adatokat (tipus, modell, sorozatszam stb.) a
Devices munkatertilet tartalmazza. Kovetkezésképpen ezeket az informacidkat nem kell
megadnia minden alkalommal, amikor adatokat olvas le a készulékrél.
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29

A Devices munkaterileten tarolt készilékek a kovetkezé két listaban jelennek meg: Active
Devices (Aktiv készilékek) vagy Inactive Devices (Inaktiv készllékek). Késziilék hozzaadasakor
az automatikusan az Active Devices listaba keriil. Csak az Active Devices listdban megjelend
készlilékekrél olvashaték le adatok. Ezek valdszinlileg a beteg altal jelenleg hasznalt
készilékek lesznek.

A beteghez tartoz6 egyéb készilékeket, amelyek hasznalaton kivil vannak, az Inactive
Devices listaban lehet tarolni. E moédszerrel megdrizhetdk az informaciok. A késziilékeket
barmikor aktivalni lehet.
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Mielott hozzakezdene...

Ahhoz, hogy megnyithassa a beteg Devices munkateriiletét, a betegnek a rendszerben

mentett profillal kell rendelkeznie. Lasd: Uj profilok hozzdaddsa 20. oldal.

Késziilék hozzaadasahoz vagy a késziilékrdl torténd kozvetlen adatbeolvasashoz a

késziiléknek kommunikalnia kell a szamitogéppel. A késziilékek szamitogéppel torténd

kommunikaciéjdhoz sziikséges beallitasainak leirasa itt olvashato: A késziilékek csatlakoztatdsa
24. oldal.

Késziilék hozzaadasa

Ha még nincs hozzdadva a késziilék, az adatokat a beteg CareLink Personal-fidkjabdl lehet

beolvasni. E készlilékeket a rendszer automatikusan felveszi a CareLink Personal és a CarelLink

Pro kozotti adatszinkronizalaskor.

MEGJEGYZES: Betegenként csak egyetlen aktiv pumpa lehet a rendszerben. Ujabb pumpa

hozzdaddsakor a madr felvett dtkeriil az inaktiv késziilékek listdjdba.

Medtronic pumpa vagy Guardian monitor hozzaadasa

1

Gy6z6djon meg arrdl, hogy a hozzdadni kivant készilék beallitdsa lehetévé teszi a
kommunikaciét a szamitdgéppel. (A kapcsolddas [épéseirdl itt olvashat: A késziilékek

csatlakoztatdsa 24. oldal.)

Kattintson a beteg adatait jelzé flilre, vagy kattintson duplan a beteg nevére a Patient
Lookup tablazatban.

Kattintson a Devices gombra ﬂ| a beteghez tartozé Devices munkaterilet eléréséhez.

Kattintson az ADD DEVICE (Késziilék hozzaadasa) gombra.

Vélassza a Medtronic Pump/Guardian lehetéséget. Megjelenik az Add Medtronic Pump/
Guardian (Medtronic pumpa/Guardian hozzaadasa) varazslé.

£ Add Medironic Pump [ Guardian

Fadel Selec tion Step 1 z | i

Saslact the Meckronic devices you veould b Eo add bo the systen.

3 e Fem

(%) Mindhed 508 pump

(Tl Minded Paradgm Seres pumg
Hind¥ied! Guardian RESL-Tme monibor

| mexr | | casn
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7

MEGJEGYZES: A pumpa modellszdima a pumpa hdtdn vagy a pumpa dllapotdt jelzé
képernyén olvashato.

A valasztégomb segitségével jelolje ki a hozzaadni kivant késziiléket.
Ha a MiniMed 508 pump lehet&séget valasztotta, ugorjon a 9. |épésre.

Kattintson a NEXT (Tovabb) gombra. Megjelenik a Serial Number (Sorozatszam) lap.

= Add Medtronic PFump [ Guardian

Serial Mumbser step 1 =@ q |

Ercerthe device's 81 character ssiel number, Found on the back of the deuice ar on Bhe skatus
ccrian. Sarial numberc may contain lottors ac wal ac numbere.

*¥ leyn mon

Device Serial Mimber:

MEGJEGYZES: Ha nem adja meg a helyes sorozatszdmot, hibaiizenet jelenik meg.
Tekintse dt a lapon Idthaté példdkat, és gy6z6djon meg arrdl, hogy a pumpa
hdtoldaldrol a helyes karaktereket adja meg. Sziikség esetén gépelje be ujra a hat
karaktert.

Az e lapon lathaté példék segitségével azonositsa a hozzdadni kivant késziiléken 1évé, hat
karakterbdl all6 sorozatszamot. (Ha az azonositdshoz tovabbi segitségre van sziiksége, a
részletekhez kattintson a >> learn more (tovabbi tudnivalék) elemre.) irja be a hat karaktert a
Device Serial Number (Készllék sorozatszama) mezébe.

Kattintson a NEXT (Tovabb) gombra. Az aldbbihoz hasonl6 Communication Options
(Kommunikaciés beallitasok) lap jelenik meg.

=8 Add Medtronic Pump § Guardian

Commisnication Oplions Step | z 3 ']
Choose which port your connectivity denvice & attached to.
5 s ey
Choose Port:
él E Aot Dubect [or LISB) “
Conex ) (oo ] [ |
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10 A Choose Port (Port kivalasztdsa) legordiilé meniibdl valassza azt a portot, amelyre a
ComlLink, a Paradigm Link’, a CareLink USB vagy a Com-Station kapcsolédik az On
szamitdgépén. Ha nem biztos abban, hogy melyik port a megfelel§, vélassza az Auto Detect
(or USB) (Automatikus észlelés vagy USB) lehet&séget.

11 Kattintson a NEXT (Tovabb) gombra. Az aldbbihoz hasonlé Test Connection (Kapcsolat
tesztelése) lap jelenik meg.

& Add Mediranic Pump §f Guardian

Test Conmed bion Step 1 Zz 1 L]

Test the conrmchion in onder 1o complete the add dece protesi.
B weirey & Parsscigm Link, devios, verify £ i OFF before continung.

5l mars

Devioe:

Par s paurt | Guardian REAL-Tire: ,u
Sa:riall Mumbers
e &=
Commmumication; )
Rt Detwct {or LESH) I I.

s .

|ll‘ [l

| mace | [ west | | cas |

12 Kovesse az utasitasokat, majd kattintson a TEST (Tesztelés) gombra.

Tajékoztato lzenet jelenik meg arra vonatkozdan, hogy a kapcsolat sikeresen létrejott-e. Ha
sikeres volt, menjen a kovetkezd lépésre.

MEGJEGYZES: A teszt nem olvassa be a pumpa adatait, hanem ellenérzi, hogy
megfelelé-e a kapcsolat a pumpa és a szdmitogép kozott.

Ha nem volt sikeres, ellendrizze, hogy a késziilék hardvere megfeleléen csatlakozik-e a
szamitogéphez. Kattintson a BACK (Vissza) gombra a varazsléban, és ellendrizze, hogy
helyesen adta-e meg a készilék adatait.

13 Kattintson a DONE (Kész) gombra.

Ezzel a késziiléket hozzdadta a beteghez tartozé Active Devices listdhoz.

Méroeszkoz hozzdadasa

1 Kattintson a beteg adatait jelzé filre, vagy kattintson duplan a beteg nevére a Patient
Lookup tablazatban.

2 Gy6z6djon meg arrdl, hogy a hozzdadni kivant méréeszkéz kommunikal a szamitégéppel. (A
kapcsolddas lépéseirdl itt olvashat: A késziilékek csatlakoztatdsa 24. oldal.)

3 Kattintson a Devices gombra a beteghez tartozé Devices munkateriilet megnyitdsahoz.

4 Kattintson az ADD DEVICE gombra.
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5 Viélassza a Blood Glucose Meter (Vércukormérd) lehetéséget. Megjelenik az Add Blood
Glucose Meter (Vércukorméré hozzaaddsa) varazslo.

J Add Blood Glucose Meter

Meter Brand Sep 1 F 3 1

Selecct e brand of master 1o would Bl o sdd bothe system
bl moew
(%} Medtronic Link Meters
O deru-Chekd (Roche)
 Ascensia® (Bayer)
IR0
() MediSense® | TheraSense {Abbott)
(e Touch (LifeScan)

mare | [ ey ] [ coamce |

6 A vdlasztégomb segitségével jel6lje ki a megfelel6 méréeszkdozmarkat.

7 Kattintson a NEXT (Tovabb) gombra. Megjelenik a Meter Model (Méréeszkdzmodell) lap (a
mérbeszkdz gyartojatol fliggéen a lap tartalma valtozhat).

&oAdd Blood Glucose Malor ril

Feter Fodel Sep | b4 5 i

Choose the Medtrondc Link mester you would B to add Eo the systam,

B b g e
. i
|
a I

oo ~ lgayer | oneTouds
P i Limkoi (COMT OIS Link Ul k™

[ oacx || tea | [ cance |

8 Kattintassal jeldlje ki a hozzaadni kivant méréeszkdzmodellt.
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9 Kattintson a NEXT gombra. Megjelenik a Communication Options (Kommunikéciés
lehet6ségek) lap.

o Add Blood Glucose Maler

£

Cosmmumicalion Oplions Step I 7 3 i

Choose wihich poret the meter & connected ko,

B ¥ g Frem

Choose Port:

[ oacx || texr | [cance |

MEGJEGYZES: Csak a hozzdadni kivdnt méréeszkoz esetén érvényes lehetéségeket
kindlja fel a rendszer.

10 A Choose Port legordiild meniibdl valassza ki azt a portot, amelyre a ComLink, a Paradigm
Link vagy a CareLink USB kapcsolodik az On szamitégépén. Ha nem biztos abban, hogy
melyik port a megfeleld, valassza az Auto Detect (or USB) (Automatikus észlelés vagy USB)
lehetéséget.

11 Kattintson a NEXT gombra. Megjelenik a Test Connection lap.

o Add Blood Glucose Maler

£

Tesk Conmection Step I 7 3 Fl

Tt B conneschon in order bo complets the add devics process,
Before romdng vouwr meter, veril'y your meter is ON,

BE T R

Deetvite:
Banyresr COMNT OUEL Linke

Ao Detect

[ oack || vesy | [ cance |

12 Kovesse az utasitdsokat, majd kattintson a TEST gombra.
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Tajékoztato Uzenet jelenik meg arra vonatkozdéan, hogy a kapcsolat sikeresen |étrejott-e. Ha
sikeres volt, menjen a kovetkezé 1épésre.

Ha nem volt sikeres, ellendrizze, hogy a késziilék hardvere megfeleléen csatlakozik-e a
szamitégéphez. Kattintson a BACK gombra a varazsléban, és ellenérizze, hogy helyesen adta-
e meg az adatokat.

Kattintson a DONE (Kész) gombra.

Ezzel a mérdeszkdzt hozzdadta a beteghez tartozé Active Devices listahoz.

Készilék aktivalasa és inaktivalasa

A beteghez rendelt késziilékeket sziikség szerint lehet mozgatni az Active Devices és az

Inactive Devices lista kozott. A késziiléknek aktivnak kell lennie ahhoz, hogy adatokat lehessen

beolvasni réla.

Tetsz6leges szamu mérbeszkozt lehet felvenni az Active Devices listara, de csak egyetlen

pumpét lehet ott tarolni. Uj pumpa hozzaadasa elétt gy6z6djén meg arrél, hogy inaktivalta a

jelenleg aktiv pumpat.

Késziilék inaktivalasa

1

Kattintson a beteg adatait jelzé filre, vagy kattintson duplédn a beteg nevére a Patient
Lookup tablazatban.

Kattintson a Devices gombra a beteghez tartozé Devices munkateriilet megnyitdsahoz. A
késziilékek helyettesitd készilékek neve alatt is megjelenhetnek. Lasd: Tdmogatott késziilékek
2. oldal.

Kattintson a >> make this device inactive (késziilék inaktivalasa) lehetéségre az inaktivalni
kivant készilék alatt. Ezzel az eszkozt az Inactive Devices listara tette.

Késziilék ujboli aktivalasa

1

Kattintson a beteg adatait jelz6 fiilre, vagy kattintson duplan a beteg nevére a Patient
Lookup tablazatban.

Kattintson a Devices gombra. A beteghez tartoz6 Devices munkateriilet jelenik meg.

A késziilékek helyettesité késziilékek neve alatt is megjelenhetnek. Lasd: Tdmogatott
késziilékek 2. oldal.

Kattintson az >> activate this device (készllék aktivalasa) lehetéségre az aktivalni kivant
késziilék alatt.

Ezzel az eszkozt az Active Devices listara tette.
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Késziilék torlése

A kovetkezd |épésekkel torolhet egy készilléket és a benne 1évé adatokat a Devices
munkateriletrél és a CarelLink Pro rendszerbél:

1 Kattintson a beteg adatait jelz6 filre, vagy kattintson dupldn a beteg nevére a Patient
Lookup tablazatban.

2 Kattintson a Devices gombra a beteghez tartozé Devices munkateriilet megnyitasahoz.

A késziilékek helyettesité késziilékek neve alatt is megjelenhetnek. Lasd: Tdmogatott
késziilékek 2. oldal.

3  Gydzédjon meg arrél, hogy az eszkdz az Inactive Devices listan van. Ha nincs, kattintson az
>> Inactivate this device (Késziilék inaktivalasa) lehetéségre az aktualis listan.

4 Kattintson a >> delete this device (késziilék torlése) lehetéségre a tordini kivant késziilék
alatt. Figyelmeztetd lzenet jelenik meg, mely arrél tdjékoztat, hogy a késziilék és a benne
tarolt adatok torlédnek a rendszerbdl.

5 A torléshez kattintson a YES (Igen) gombra.

A készilék és a benne tarolt adatok torlédnek a Devices munkateriiletrél és a Carelink Pro
rendszerbdl. A késziilék adatait tobbé nem lehet jelentések készitésére hasznalni.

Késziilék adatainak beolvasasa

Az adatok beolvasasanak egyik modja a beteg meglévé CarelLink Personal-fiokjahoz vald
kapcsolddés. (Tovabbi informaciot a kovetkezd helyen taldl: Kapcsolddds a CarelLink Personal
szoftverhez 21. oldal.) Egy masik lehet6ség az e fejezetben leirt médon torténé kdzvetlen

beolvasas a készulékrol.

A beteg készllékén tarolt adatokat akkor tudja beolvasni a CareLink Pro, ha a késziilék az
Active Devices listdn van és kommunikal a szamitégéppel. Az adatok beolvasas utan
felhasznalhatdk jelentések készitésére és a beteg terdpias kezelésének kiértékelésére. A
rendelkezésre all6 jelentésekrél a kovetkezé helyen olvashat rovid leirdst: A jelentésekrél
44. oldal.

A CareLink Pro az aldbbi adatokat tudja beolvasni egy inzulinpumpabdl:

« apumpa kiilénféle bedllitasai, példaul a riasztas mddja, a hangjelzés ereje és az id6 kijelzése
« a beadott bazisinzulin mennyisége

+  bolusesemények és beadott mennyiségek

« a Bolus Wizard bejegyzései

«  a feltoltési mennyiségek

« a felfliggesztési id6szakok

« a szenzor adott idészakban mért glikézadatai, a szenzorral ellatott pumpakon

A rendszerrel a Guardian REAL-Time rendszerrdl is gydjtheték adatok, példaul az alabbiak:

« a szenzor altal mért glikdzértékek (SG)
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a szenzor koefficiens értékei
a szenzor kalibraciés tényezdi
étkezésmarkerek

inzulininjekciok

Ezenkivul a vércukormérdkben tarolt killonféle informacidk is feltdltheték a rendszerbe a

késziilékleolvasasok soran.

VIGYAZAT! Ehhez fiiggessze fel vagy fejezze be az ideiglenes bdzis vagy az aktiv bolusok

beadadsat, és tordlje az aktiv riasztdsokat. A beolvasds idejére a pumpa miikodését

felfiiggeszti a rendszer. A beolvasds végén ellenérizze, hogy a pumpa tjra miikodésbe

lépett-e.

FIGYELEM! A pumpa adatainak beolvasdsa kézben ne haszndlja a tdvirdnyitét. Ha a

pumpa elemének toltottsége alacsony, a pumpa nem kiild adatokat a szamitégépnek.

Cseréljen elemet, ha az dllapotjelz6 alacsony téltottséget jelez.

Kattintson a beteg adatait jelz6 fiilre, vagy kattintson duplan a beteg nevére a Patient

Lookup tablazatban.

Gy6z8djon meg arrdl, hogy a beteg késziléke kommunikal a szamitdgéppel. (Tovabbi
informaciét a kovetkezd helyen talal: A késztilékek csatlakoztatdsa 24. oldal.)

Kattintson a Devices gombra a beteghez tartozé Devices munkateriilet megnyitdsahoz.

A késziilékek helyettesité késziilékek neve alatt is megjelenhetnek. Lasd: Tdmogatott
késziilékek 2. oldal.

Azonositsa az Active Devices listdban a késziiléket, amelyrél adatokat szeretne lekérdezni, és
gy6z6djon meg arrél, hogy a Choose port lehetéségnél megfelel6 valaszt adott meg.

Pumpa adatainak lekérdezéséhez az Amount of Data (Adatmennyiség) legoérdilé meniibdl
vélassza ki azt az adatmennyiséget, amelyet be kivan olvastatni a CareLink Pro rendszerrel.

Kattintson a READ DEVICE (Késziilék beolvasasa) gombra.
Kbvesse az utasitasokat, majd kattintson az OK gombra.

A CareLink Pro frissiilé folyamatjelzével mutatja, hogy a készllék beolvasdsa milyen
mértékben teljesilt.

Ha a készililék beolvasdsakor a CANCEL (Mégse) gombra kattint, a megjelen Uzenet arra
figyelmezteti, hogy a m(velet visszavondsa a beolvasott adatok elvesztésével jar. A feltoltés
Ujrainditdsdhoz a READ DEVICE gombra kell kattintania.

- A visszavonashoz kattintson a YES gombira.

- Az adatok beolvasasanak folytatasahoz kattintson a NO gombra.

Ha a rendszer befejezte a készllék adatainak beolvasasat, megjelenik egy a folyamat
teljestilését megerdsitd Uizenet.
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8 Kattintson az OK gombira.
- Pumpanal kovesse az utasitasokat a felfliggesztett méd megsziintetéséhez.

Ha a CareLink Pro nem tudja beolvasni a készllék adatait, tovabbi Utmutatasért olvassa el a
Hibaelharitds cim( részt.
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A Reports (Jelentések) munkaterilet

A CareLink Pro szamos jelentéstipust biztosit a diabéteszes betegek kezelésének hatékonyabb
nyomon kovetéséhez. Az e jelentésekben taldlhaté adatok a beteg késziilékeibdl és CareLink
Personal-fiokjabdl beolvasott adatokra épulnek.
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A jelentéseket a képernydn lehet l1étrehozni, kézvetleniul nyomtatéra lehet kildeni, valamint
TIFF vagy PDF formatumban lehet menteni és elektronikus kérlaphoz (Electronic Medical
Record) csatolni. Egyetlen muvelettel szamos jelentéstipust hozhat létre.

A jelentésekben foglalt adatokat a beteg késziilékérdl vagy CareLink Personal-fiokjarol
(esetleg mindkettérél) lehet letolteni.

MEGJEGYZES: A jelentések elemeirél tovdbbi részleteket és jelentésmintdkat a jelentések
utmutatdjdban taldl. A jelentések utmutatéjanak megnyitdsdhoz a Carelink Pro szoftver
Help (Sugd) meniijében kattintson a View Report Reference Guide (PDF) (Jelentések
utmutatéjdnak megtekintése) parancsra, és vdlassza ki a megfelel6é nyelvet.
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Mielott hozzakezdene...

Ahhoz, hogy a jelentésbe bele tudjon foglalni egy adott idészakot, rendelkeznie kell a beteg
késziilékének adataival arra az id6északra. Jelentéskészités eldtt sziikséges lehet az is, hogy a
beteg késziiléke csatlakozzon a szamitdégéphez, hogy az aktualis adatok lekérdezhet6k
legyenek.

Jelentéskészités el6tt gyd6zddjon meg arrdl, hogy alaposan attanulmanyozta a Verify Report
Settings (Jelentés beallitasainak ellenbrzése) [épést. Itt tudja beallitani a jelentés részleteit

ahhoz, hogy a kivant betegadatokat tudja letolteni.

Jelentések létrehozasa

A kovetkezd részekbdl megismerheti a rendelkezésére allé jelentéseket és megtudhatja,
hogyan hozhatja létre ezeket.

Ha mar ismeri a jelentéskészités menetét és tudja, hogy milyen jelentéseket fog késziteni,
megkezdheti a jelentések létrehozasat.

A Reports munkateriilet megnyitasa

Kattintson a beteg adatait jelz6 fiilre, vagy kattintson az Open Patient (Beteg adatainak

megnyitasa) gombra & , és kattintson duplan a beteg nevére.

Megjelenik a Reports munkaterilet.

MEGJEGYZES: Ahhoz, hogy biztosan a legfrissebb késziilékadatokkal rendelkezzen a beteg
CarelLink Personal-fiokjdbdl, kattintson a SYNC DATA (Adatszinkronizdlds) gombra.

A jelentés id6szakanak kivalasztasa

1 A jelentés(ek) id6szakanak mddositasahoz a Duration (Idétartam) legordiilé mentibdl
valassza ki a kivant idétartamot. (A leghosszabb idétartam 12 hét.)

2 Az id6szak kezd6 és zaré datumat automatikusan bedllitja a rendszer, de a felhasznald

modosithatja ezt a custom date range (egyéni datumtartomany) beallitassal.

MEGJEGYZES: A megengedettnél hosszabb idészak kivdlasztdsakor a rendszer
hibaiizenetet kiild. Médositsa az idétartamot vagy a datumokat.

Ha a datumtartomdany egyéni bedllitasat valasztja, kattintson a From (Kezd6é datum) és a
Through (Zaré datum) legordulé listara a kivant hénap, nap vagy év kivalasztasahoz.

Adatnaptar

A Reports munkaterilet adatnaptar-tertilete haromhdnapos idészakokra bontva mutatja meg

a jelentésbe foglalhaté adatokat.
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A kék savok a késziilékbdl szarmazéd adatokat, a narancssarga sav pedig a kivalasztott jelentési
idészakot jelképezi. A késziilékadatok és a jelentési id6szak kozotti atfedés azt jelenti, hogy az
adatok rendelkezésre allnak a kivalasztott jelentési id6szak egy részére vagy egészére.
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Az adatnaptar-teriileten elséként az elmult harom hénap adatai lathatdk. A tobbi héonap

adatainak megtekintéséhez kattintson a hénapsav elején vagy végén lévé nyilra ¢ *.

A jelentésbe foglalandé forrasadatok kivalasztasa

1 Ha a beteg olyan vércukorszintmérét hasznal, amely csatlakozik a pumpajahoz, a méréeszkoz

VC-értékeinek jelentésbe foglalasdhoz kattintson a kovetkezd lehetéségek egyikére:

- In the pump (Pumpa adatai): E valasztas elénye, hogy elegendé a beteg pumpdjanak
adatait beolvasni, mert a VC-értékeket a pumpa idébélyeggel latja el, és az értékek
kozvetlenil a Bolus Wizard szamitasaihoz kapcsolédnak. Hatranya, hogy ha
kommunikaciés nehézségek vannak a pumpa és a csatlakozé mérbéeszkoz kozott, az
adott idészak VC értékei-nem fognak szerepelni a jelentésben. Hasonléképpen az 522/
722-es tipusndl kordbbi MiniMed Paradigm pumpaknal a Bolus Wizard szamitasai altal
nem érintett VC-értékek szintén nem keriilnek be a jelentésbe.

- In the link meter(s) (Méréeszkéz adatai): E valasztas elénye, hogy a csatlakozé
mérdeszkdzben tarolt 6sszes érték bekerll a jelentésbe. Hatranya, hogy a méréeszkoz és
a pumpa adatainak korrelaciéjahoz elézetesen szinkronizalni kell a pumpa és a
mérdeszkdz idémérdjét. A pumpa és a csatlakozé méréeszkdz adatait kilon-kalon kell
beolvasni.

2 A készulék adatainak jelentésbe foglaldsdahoz jeldlje ki a megfelel késziilék mellett 1évd
négyzetet.

Az 1. lépésben hozott valasztas eredményeként kizart készlilékek adatai nem adhatdk a
jelentéshez. Ennek megvaltoztatdsdhoz vélassza a masik (méréeszkoz) lehetbséget.

3 A készulék adatainak jelentésbdl torténd kizdrdsdhoz sziintesse meg a megfeleld késziilék
mellett [évé négyzet kijelolését.

Az 1. lépésben hozott valasztas fliggvényében bizonyos kijeloléseket nem sziintethet meg.
Ennek megviéltoztatdsdhoz vélassza a masik (mérbéeszkdz) lehetbséget.

A késziilékadatok ellenorzése

1 A Reports munkateriileten 1évé naptaron ellenérizze, hogy a jelentési idészakot jelképezd
narancssarga sav atfedi-e a késziilékadatokat abrazolo kék savokat.
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Ha a savok atfedik egymast a teljes jelentési id6szakban, a jelentéshez sziikséges adatok
rendelkezésre allnak. Kattintson a NEXT (Tovabb) gombra, és folytassa a kdvetkezdvel:
Jelentés bedllitdsainak ellenérzése 41. oldal.

Ha a sadvok nem vagy csak kis mértékben fedik at egymast, a kdvetkezdket teheti:
- Mddosithatja a jelentési id6szakot.
- Tovabbi késziilékadatokat olvashat be.

Tovabbi késziilékadatok beolvasasa

1

Tovabbi adatok beolvasdsahoz kattintson a READ DEVICE (Késziilék beolvasdsa) gombra.

Megjelenik a Read Device sav.
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VIGYAZAT! Ehhez fiiggessze fel vagy fejezze be az ideiglenes bdzis vagy az aktiv
bolusok beaddsadt, és torolje az aktiv riasztdsokat. A beolvasds idejére a pumpa
miikodését felfiiggeszti a rendszer. A beolvasds végén ellendrizze, hogy a pumpa ujra
miikédésbe Iépett-e.

FIGYELEM! A pumpa adatainak beolvasdsa kézben ne haszndlja a tdvirdnyitot. Ha a
pumpa elemének toltottsége alacsony, a pumpa nem kiild adatokat a szamitégépnek.
Cseréljen elemet, ha a késziilék dllapotjelzéje alacsony toltottséget jelez.

Ellenérizze, hogy a Choose port (Port kivalasztasa) lehetéségnél megfelelé valaszt adott-e
meg.

A bedllitds megvaltoztatdsdhoz kattintson a mez6hoz tartozé legordiil listéra, és valasszon
masik bedllitast.
Ellendrizze, hogy a késziilék a szamitdgéphez van-e csatlakoztatva.

Ha a késziilék pumpa, megadhatja a lekérni kivant adatmennyiséget. Kattintson az Amount
of Data (Adatmennyiség) legordiilé meniire, és vélasszon értéket.

MEGJEGYZES: Ha az All available data (Minden rendelkezésre dllé adat) lehetéséget
vdlasztja, a rendszer a pumpdban rendelkezésre dllé6 6sszes adatot beolvassa. Ezzel
feliilirja a rendszerben dupldn meglévé adatokat.

Kattintson a READ DEVICE gombra. Gondosan olvassa el a megjelend lizenetet, mert abban
fontos tudnivaldkat taldl a pumpa adatainak beolvasasarol.

Kodvesse az utasitasokat, majd kattintson az OK gombra.
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Megjelenik a késziilék beolvasasat jelzd folyamatsav.

A beolvasast barmikor leallithatja, ha a CANCEL (Mégse) gombra kattint.
A beolvasas végét meger6sitdé Gzenet jelenik meg.

Kattintson az OK gombra.

Ekkor megjelennek a késziilékadatok az adatnaptaron beldl.

Kattintson a Reports munkatertilet tetején taldlhat6 NEXT gombra.

Megjelenik a Verify Report Settings lépés. Itt ellendrizheti jelentéskészités el6tt, hogy a

betegre érvényes bedllitadsok megfeleldk-e.

Jelentés beallitasainak ellendrzése

1

Ellenérizze, hogy megfelel6k-e a Glucose Target (Vércukor célértéke) beéllitasai. irja be a
megfelel6 értékeket, vagy kattintson a felfelé vagy lefelé mutaté nyilra a Low (Alsd) vagy a
High (Felsé) mezében az értékek noveléséhez vagy csokkentéséhez.

MEGJEGYZES: A mért értékek markerei (|| |) megjelennek a felkelés és lefekvés
idotengelyén, valamint az étkezési markerek idétengelyén is. Mivel a jelentések
némelyike meghatdrozott étkezési idoszakokra, illetve felkelési és lefekvési
idépontokra es6 adatokat vesz alapul, ezért fontos, hogy a beteg Bolus Wizard-
eseményeihez és méréseihez tartozo markerek megfelel6en legyenek csoportositva.

Uj étkezési idészak hozzaadasahoz kattintson az ADD MEAL (Etkezés hozzaadasa) gombra.
Létez6 étkezési idGszak szerkesztéséhez kattintson barhova az idétengely mentén az étkezési

id6szak tertletén.

Ekkor az idétengely alatt talalhatd Meal Period (Etkezési idészak) szerkesztd aktivva valik.

MEGJEGYZES: Osszesen 6t étkezési idészakot vdlaszthat. Az alapértelmezettek a
reggeli, ebéd és vacsora.

irja be az adatokat, vagy a nyilak segitségével adja meg a kivant beallitasokat.

Ha a beadllitasokat csak erre az étkezésre kivanja alkalmazni, torélje a Use these parameters
for all of this patient's meals (Ezen paraméterek alkalmazdasa a beteg 0sszes étkezésére)
jelolénégyzet jelolését.

- Meal Name (Etkezés megnevezése): Az étkezési id6szaknak adni kivant név.

- Meal Time Period (Etkezés ideje): Az étkezési id6 kezdetét és végét jelzé orak.

- Pre-Meal BG Target (mg/dL vagy mmol/L) (Etkezés el6tti VC-célérték, mg/dl vagy
mmol/l): A beteg étkezés eldtti vércukor-céltartomanyanak alsé és felsé hatara.

- Pre-Meal Analysis Period (Etkezés el6tti elemzés ideje): Megadja, hogy az étkezés
elétt mennyi id6vel kerlljon sor vércukorelemzésre. Az ebben az idészakban rogzitett
vércukorszint-értékek a részletes jelentéselemzésbe kerilnek.

- Post-Meal BG Target (mg/dL vagy mmol/L) (Etkezés utani VC-célérték, mg/dl vagy
mmol/l): A beteg étkezés utani vércukor-céltartomanydanak alsé és felsé hatéra.
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- Post-Meal Analysis Period (Etkezés utani elemzés ideje): Megadja, hogy az étkezés
utdn mennyi idével keriljon sor vércukorelemzésre. Az ebben az idészakban rogzitett
vércukorszint-értékek a részletes jelentéselemzésbe kerilnek.

Az étkezési id6szakok hosszat vagy a felkelés és a lefekvés idejét a sdvok elején vagy
végén lévs fogantyukra kattintva, azokat az id6tengely mentén a kivant helyre huzva
valtoztathatja meg.

MEGJEGYZES: Az étkezési idészakok kézott nem lehet dtfedés, de kezdé és zdré
idopontjuk révén hatdraik egybeeshetnek. Az étkezési idészakoknak legaldabb 60

perceseknek kell lenniiik.

Ha ezeket a bedllitasokat kivanja alkalmazni a beteg 0sszes étkezésére, jeldlje be a Use these
parameters for all of this patient’s meals jel6I6négyzetet.

Az étkezési idbszak létrehozasanak vagy szerkesztésének végén kattintson a SAVE (Mentés)

gombra.

Etkezési idészak eltavolitdsahoz kattintson a DELETE MEAL (Etkezés torlése) gombra. Amikor

a rendszer meger6sitést kér, kattintson a DELETE gombra.

A CareLink Pro képes tarolni az ehhez a beteghez megadott bedllitdsokat a kovetkezd
jelentéskészitéshez. Ehhez kattintson a SAVE SETTINGS (Bedllitdsok mentése) gombra.

Kattintson a Reports munkatertilet tetején talalhat6 NEXT gombra.
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9

Megjelenik a folyamat Select and Generate Reports (Jelentések kivalasztasa és létrehozasa)
lépése. A képernybn a jelentéstipusok listdja és egy adattabla lathatd, melyek segitségével
kivalaszthatja, mely napok adatait veszi fel és melyeket hagyja ki a részletes napi

jelentésekbdl.
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MEGJEGYZES: Az adattdbla megjelenésének médositdsdhoz kattintson a >> customize
columns (oszlopok testreszabdsa) elemre. Ldsd: A jelentéskészitéssel kapcsolatos
bedllitdsok 16. oldal.

A képernyén lathato tartalom kinyomtatasahoz kattintson a PRINT (Nyomtatas) ikonra .

Jelentéstipusok és felvenni kivant datumok kivalasztasa

1
2

Jeldlje be a jelentéslistaba foglalni kivant jelentés(ek) mellett 1évé jel6lénégyzeteket.

Ha az adott jelentési idészakban tobbszor is beolvastdk a pumpa vagy a Guardian monitor
adatait, tobb pillanatkép is Iétezhet a késziilékrél:
a. Gy6z6djon meg arrél, hogy a Device Settings Snapshot (Késziilékbeallitasok
pillanatképe) jel6lénégyzet be van jeldlve.
b. Kattintson a legordiilé nyilra, majd valassza ki a pillanatkép datumat és idejét.
- Pumps (Pumpak): Vélasszon pillanatképet a beteg pumpdjabdl.
- Guardian: Vdlasszon pillanatképet a beteg Guardian monitorabdl.

Ha a mezdék barmelyike sziirke, akkor nem all rendelkezésre pillanatkép a jelentési id&szakra.
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Gorgesse végig az adattdblat, és tekintse &t a rendelkezésre 3llé6 napi jelentéseket.

- Mindegyik oszlopban rendezheti az adatokat. Az oszlop fejlécére kattintva névekvo
sorba rendezheti az adatokat. Ismét az oszlop fejlécére kattintva csokkendé sorba
rendezheti az adatokat.

MEGJEGYZES: Nem lehet kivdlasztani egy bizonyos napot, ha nincs adat arra a
napra.

Jeldlje be az adattablasorok jelolénégyzeteit azon datumok mellett, amelyekre Daily Detail

jelentést kér.

- Az Osszes napi jelentést felveheti vagy kihagyhatja egyetlen kattintassal, ha az adattabla
tetején a jelolénégyzetek oszlopa folotti jel6lénégyzetre kattint.

Jelentések létrehozasa

1 A jelentések kivalasztasanak ellendrzése utan kattintson a GENERATE REPORTS (Jelentések
létrehozadsa) gombra a Reports munkateriilet tetején.
Megjelenik a lehetéségek listdja.

2 Valassza a jelentés(ek) megtekintésének, nyomtatdsanak vagy mentésének lehetéségét.
Ha a Preview (Megtekintés) lehet6séget valasztotta, a Preview ablak jelenik meg.

3 A nyilakra kattintva végigbdngészheti a tobboldalas jelentéseket.

4 Kattintson a Preview ablak tetején |évé gombok egyikére a jelentés(ek) mentéséhez vagy
nyomtatasahoz.
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5 Az ablak bezéarasahoz kattintson az ablak jobb felsé sarkaban talalhaté Close (Bezaras)
gombra E.

A jelentésekrol

Az alabbiakban az egyes jelentések leirdsat olvashatja. A jelentések elemeirdl tovabbi

részleteket és jelentésmintdkat a jelentések Utmutatdjaban taldl. A jelentések utmutatojat a

CareLink Pro alkalmazasbdl érheti el:

1

2

Help > View Report Reference Guide (PDF) (Sugd > A jelentések PDF formatumu
utmutatdjanak megtekintése).

Vélasszon nyelvet a jelentések Utmutatéjanak megtekintéséhez.

A CareLink Pro jelentéseinek kozos jellemzéi:

Jelentés fejléce — A jelentés fejléce azonosité adatokat tartalmaz, példaul a jelentés nevét, a
beteg nevét és az adatok forrasat.

Szénhidratok és vércukorszint — A grafikonokon és diagramokon a szénhidrategységek
délten, a vércukorszintegységek félkovéren jelennek meg.
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« Hétvége adatai — A hétvége napjai félkdvéren jelennek meg a kdnnyebb azonositas
érdekében.

- Jelmagyarazat - A jelentések végén jelmagyardzat lathaté. A szimbdélumok tobb jelentésben

is el6fordulhatnak, de a jelentések jelmagyarazatai egyediek.

Betartasi jelentés

A betartasi jelentés az inzulinpumpdk és szenzorok hasznalatat leiré adatokat szolgaltat, és
megmutatja a beteg viselkedését a terapiaval szemben. A kovetkezd kérdésekre ad valaszt:
van-e elegendd adat annak pontos megitélésére, hogy a beteg miként hasznalja
inzulinpumpajat és szenzorat, ha kapott ilyet? Betartja-e a beteg a terdpiads utasitasokat? Azt is
megmutatja, hogy sziikséges-e beszélnie a beteggel arrél, hogy miként viszonyul
cukorbetegségéhez.

A szenzor- és mérdadatok 6sszefoglalo jelentése

A szenzor- és mérdadatok Osszefoglald jelentése grafikus képet ad a beteg mért
vércukorszintjérél és az atlagértékekrél, a nap 24 6rajarol 6rankénti bontasban, valamint arrdl,
hogy ezek miként viszonyulnak a beteg étkezési és alvasi szokdsaihoz. A jelentés a beteg
vércukorszintjét és inzulinhasznélatat tikroz6 statisztikat is tartalmaz.

Ha vannak szenzoradatok, akkor a rendszer azokrdl hasonlo elemzést készit, mint ennek a
jelentésnek az elsé oldala. Ha nincsenek szenzoradatok, a jelentés elsé oldaldan a méréeszkoz
adatainak elemzése lathato.

A jelentés utolso oldalai a beteg napi glikémias, szénhidrat- és inzulinkontrolljdnak szintjét és
mindségét mutatjak. Az oldalanként legfeljebb 14 nap adatat mutaté lapok jelzik, miként
valtozik naponta ez a kontroll a jelentési id6szakban.

Napldjelentés

A napldjelentés a jelentési idészak napjain a méréeszkdz altal mért vércukor-, szénhidrat- és
inzulinadatokat mutatja. Az éranként rogzitett eseménynaplé mellett tartalmazza a napi
adatok atlagat és 6sszegzését is. Mindegyik oldal legfeljebb 14 nap adatat tartalmazza. Ha a
jelentési id6szak hosszabb 14 napnal, a rendszer tovabbi oldalakat ad a jelentéshez.

Készilékbeallitasok pillanatképe

A késziilékbedllitasok pillanatképe a pumpa vagy a Guardian REAL-Time monitor adott
dadtumra és idépontra érvényes beallitdsainak pillanatképét tartalmazza. Ennek segitségével
értelmezheti a tobbi jelentést, vagy csak dokumentélhatja a betegre érvényes beallitdsokat.

A pumpa vagy a monitor beallitasait csak a késziilékek beolvasasakor lehet rogziteni. Ha a
készlilék adatait nem olvastak be a jelentési idészakban, a beallitdsok nem &allnak
rendelkezésre.
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Részletes napi jelentés

A részletes napi jelentés megmutatja a beteg vércukorszintjét, szénhidratmennyiségeit és
inzulinfogyasztasat a kivalasztott napra. Az adattdblan kivalasztott mindegyik naprol kilon
jelentés késziil.

A részletes napi jelentés megmutatja a kivalasztott nap 0sszes részletét. Segitségével egy
adott napra dsszpontosithat, ha ugy érzi, hogy azon a napon a beteg terapidja szempontjabol
fontos esemény tortént.

Adatexportalas

A CareLink Pro lehetéséget ad az altal beolvasott és tarolt késziilékadatok exportaldsara.
Ennek segitségével statisztikai célokra vagy specialis jelentések és diagramok készitéséhez
gyljtheti 6ssze a beteg 6sszes késziilékadatat. A .csv fajl importdlhaté a Microsoft Excel
alkalmazésba vagy egyes klinikai statisztikai programokba a tovabbi adatkezeléshez.

A .csv fajl a készllék miveleteit rogzité adatokat tartalmaz. Példaul megjeleniti a mért értékek
rogzitését, a mérdeszkdzzel mért érték pumpa altali fogadasat vagy a bazisinzulin valtozasat.

MEGJEGYZES: Ez olyan specidlis szolgdltatds, amelyhez sziikséges a késziilék sajdt
adatformdtumdnak ismerete. Ismerni kell azt a szoftvert is, amelybe a .csv fdjlt
importdlja.

A CarelLink Pro exportaldsi szolgaltatasat a kovetkezd [épésekkel veheti igénybe:

1 Kattintson a beteg adatait jelzé filre, vagy kattintson az Open Patient (Beteg adatainak

megnyitdsa) gombra & , és kattintson duplan a beteg nevére.

2 Ellendrizze, hogy megjelenik-e a Reports munkaterilet.

3 A Duration (Id6tartam) vagy a From/Through (Kezd6é datum/Zaré datum) mezoékkel allitsa
be a datumokat és a jelentés hosszat.

A leghosszabb vélaszthaté id6tartam 12 hét.
4 Kattintson az export selected data (kivalasztott adatok exportaldsa) hivatkozasra.

Ekkor megjelenik az Export Data to CSV File (Adatok exportdlasa CSV-fijlba)
parbeszédpanel.

5 Lépjen a szamitdogép ama mappajara, amelyben a .csv fajlt tarolni szeretné. Ha médositani
szeretné a fajl nevét, irja be a kivant nevet a File name (Fajlnév) mezdbe.

6 Kattintson a SAVE (Mentés) gombra.

MEGJEGYZES: A CSV-fdjlban megjelené adatokrél a CSV-adatokat ismerteté fiiggelék
ad részletes tdjékoztatdst.
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Ezzel mentette a .csv fajlt a szamitdgépen a kivalasztott helyre. Ezek utan a fajltipust
tamogatd barmelyik programba importalhatja azt.
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Rendszerfelligyelet

Fontos, hogy rendszeresen készitsen biztonsdgi masolatot a CareLink Pro-adatbazisrol. Az
adatbdzis a beteg rekordjaiban 6sszegy(lt 6sszes rendszeradatot tarolja, igy a profiladatokat,

a készlilékbdl nyert adatokat és a jelentésbeallitasokat is.

Fontos az is, hogy a CareLink Pro legujabb verziéjaval rendelkezzen. Rendszeres id6k6zonként
jelennek meg frissitett verzidk, amelyek fontos uUjitasokat tartalmazhatnak. Valaszthat, hogy
On kivanja ellenérizni, hogy vannak-e Uj frissitések, vagy értesitést szeretne kapni azok

megjelenésérdl.

Szoftverfrissitések alkalmazasa

A CareLink Pro szoftverhez alkalomszerten jelennek meg frissitések. Ha megjelenik egy
frissitésrél tajékoztatd értesités, a legujabb szoftverkiadas letoltéséhez hajtsa végre az aldbbi

[épéseket.

MEGJEGYZES: A szoftverfrissitések telepitése el6tt az adatbdzisrél biztonsdgi mdsolatot
kell késziteni. Ldsd: Az adatbdzis biztonsdgi mentése 49. oldal.

1 Gyd6z8djon meg arrdl, hogy a szamitégép kapcsolddik az internetre.

2 Ha van elérhet6 frissités a CareLink Pro szoftverhez, megjelenik a CarelLink Pro Update
(CareLink Pro-frissités) lizenet. Az Gizenet felajanlja a frissités letoltésére szolgald lehetdséget.

3 Kattintson a DOWNLOAD (Letoltés) gombra. (Ha a CANCEL (Mégse) gombra kattint, a
frissitési Uzenet bezardédik. Ez esetben a frissitést egy késébbi idépontban is letdltheti.)

Megjelenik egy az adatbazis biztonsagi mentését felajanlé figyelmeztetd lizenet.

4 A biztonsagi masolat Iétrehozasahoz kattintson a YES (Igen) gombra (errél az eljarasrol 1asd:
Az adatbdzis biztonsdgi mentése 49. oldal). Kattintson a NO (Nem) gombra, ha mar készitett

biztonsagi masolatot.

A CareLink Pro Uj verzidjanak letoltését egy lizenet megjelenése jelzi.
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5 Ha meg kivanja kezdeni a CareLink Pro legujabb verzidjanak hasznalatat, a szoftveralkalmazas
bezdarasahoz, majd ujbdli megnyitdsahoz kattintson a YES gombra. Kattintson a NO gombira,
ha a CareLink Pro hasznalatat nem kivanja azonnal megkezdeni.

Az automatikus frissitések kikapcsolasa

Ha nem szeretné megkapni a CareLink Pro frissitéseirél sz616 automatikus értesitéseket, kovesse
az alabbi lépéseket:

1 Valassza a Tools > Options (Eszk6zok > Beallitdsok) parancsot.

2 Kattintson a General (Altalanos) fiilre.

3 A Communications (Kommunikacid) csoportban torélje az Automatically check for
software updates (Szoftverfrissitések automatikus keresése) jelolénégyzet jelolését.

Frissitések manualis keresése

Manudlisan barmikor ellendérizheti, hogy vannak-e elérheté frissitések a CarelLink Pro
szoftverhez.

MEGJEGYZES: A szoftverfrissitések telepitése el6tt az adatbdzisrél biztonsdgi mdsolatot
kell késziteni. Ldsd: Az adatbdzis biztonsdgi mentése 49. oldal.

1  Gydz6djon meg arrél, hogy a szamitégép kapcsolddik az internetre.
2 Vdlassza a Tools > Check for Software Updates (Szoftverfrissitések keresése) lehetéséget.

3 Ha nincs elérhet6 frissités, a program megjelenit errél egy lizenetet. Ha van elérhetd frissités,
megjelenik a CareLink Pro Update Uzenet.

4 Kovesse a kovetkezd részben leirt eljarast: Szoftverfrissitések alkalmazdsa 48. oldal.

Az adatbazis biztonsagi mentése és visszaallitasa

Célszerl egy szabalyos id6kozonkénti Gtemezést beallitani az adatbazis biztonsagi
mentésének végrehajtasahoz. Ezzel biztosithatd a rendszeresség, és minimalizalhato az
adatvesztés kockazata.

Adatbazis biztonsagi mentése vagy visszadllitdsa esetén a program figyelmezteti, ha mas
szamitégépeken a szoftvert hasznald aktiv felhasznaldkat észlel.

Az adatbazis biztonsagi mentése

Az alabbi |épésekkel a kivant helyen elkészitheti az aktudlis adatbazis biztonsagi masolatat.
1 Gy6z8djon meg arrél, hogy az dsszes rekord be van zarva.

2 Vdlassza a Tools > Backup Database (Eszk6zok > Adatbazis biztonsagi mentése)
menupontot.

CareLink Pro Hasznalati utmutaté  Rendszerfelligyelet 49



MEGJEGYZES: Az adatbdzis biztonsdgi mdsolata hdlézati meghajtéra vagy cserélheté
adathordozékra (DVD-re, CD-re, USB-meghajtora stb.) egyardnt menthetd.

3 Lépjen a szamitdégépnek arra a mappajara, amelybe menteni szeretné a biztonsagi masolatot.
Ha modositani szeretné a biztonsagi masolat fajljanak nevét, irja be a kivant nevet a File
name (Fajlnév) mezébe.

4 Kattintson a Save (Mentés) gombra. Az adatbdzis mentése soran egy folyamatsav lathatd.
A biztonsagi mentés befejez6désérél egy lizenet tajékoztatja.

5 Kattintson az OK gombra az lizenet bezarasahoz.

Az adatbazis visszaallitasa

Eléfordulhat, hogy az aktudlis adatbazist le kell cserélni, ha az mar nem érheté el vagy nem
hasznalhaté. Minél aktualisabb a biztonsagi masolat, annal kevesebb adat vész el az
adatbazis cseréje esetén.

FIGYELEM! Az adatbdzis biztonsdgi mdsolattal torténé visszadllitdsa esetén a kivdlasztott
biztonsdgi mdsolat készitése ota létrehozott minden adat elvész.

Az aldbbi |épésekkel kivalaszthatja azt a biztonsdgi masolatot, amelyre le kivanja cserélni az
aktualis adatbazist.

1 Gy6z8djon meg arrél, hogy az 6sszes rekord be van zérva.
2 Vdlassza a Tools > Restore Database (Adatbazis visszaallitasa) parancsot.

3 Jeldlje ki azt a biztonsagimasolat-fajlt, amelyet az aktudlis adatbazis lecseréléséhez hasznalni
kivan (ez altaldban a legujabb fajl).

4 Kattintson az Open (Megnyitds) gombra. Ekkor megjelenik egy arra figyelmeztet6 lizenet,
hogy az adatbazis visszadllitdsanak folytatdsa adatvesztést okozhat.

5 A folytatdshoz kattintson az OK gombra. Az adatbdzis visszadllitdsa sordn egy folyamatsav
lathato.

A visszadllitas befejez6désérél egy lizenet tajékoztatja.

6 Kattintson az OK gombra az lizenet bezéarasdhoz.

Teenddk a rendszer elérhetetlensége esetén

Ha ugy probalja elinditani a rendszert, hogy kdzben egy masik felhasznalé biztonsagi mentést
vagy visszaallitadst végez, megjelenik egy arrdl tdjékoztatd lizenet, hogy a rendszer nem érheté
el. A feladat befejez6déséig nem érheti el a rendszert.

A kovetkezé lehetdségek kozil valaszthat:
«  Varjon, amig a folyamat befejezédik és a rendszer elérhet6évé vilik.

«  Kattintson a CANCEL gombra a kilépéshez, és probalkozzon ujra késébb.
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Hibaelharitas

Ez a fejezet segitséget nyujt a CareLink Pro szoftver hasznélata soran esetleg eléfordulé hibdk

megoldasdhoz, tovabba a CarelLink Pro esetleg szlikségessé valé eltavolitdsdhoz is itmutatast

nyujt.

Altalanos alkalmazashasznalati hibak

Ha megkisérel letolteni egy szoftverfrissitést az interneten keresztil, elé6fordulhat, hogy

tajékoztatd lizenet jelenik meg arrél, hogy nincs ehhez elegendd jogosultsaga. A CarelLink Pro

frissitéseinek letoltéséhez rendszergazdai jogosultsagokkal kell rendelkeznie.

1
2

3

Zarja be a Carelink Pro alkalmazast, és inditsa Ujra a szamitdgépet.

Kérjen meg egy rendszergazdai jogosultsagokkal rendelkezé felhasznalot, hogy jelentkezzen

be a szamitogépre.

Kovesse a kovetkezd részben taldlhatd utasitasokat: Szoftverfrissitések alkalmazdsa 48. oldal.

Nincs kapcsolat az adatbazissal

Egy az adatbdazissal vald kapcsolat megszakadasat jelzé hibatlizenet az aldbbiak egyikérdl

tajékoztat:

The database has been moved. The database must be located in the same place that was
selected during installation of the CarelLink Pro software. If it has been moved, it must be
moved back to the location selected during installation. (Az adatbazist athelyezték. Az
adatbazisnak a CarelLink Pro szoftver telepitése sordan megadott helyen kell lennie. Ha azt
id6kozben athelyezték, vissza kell helyezni a telepités soran kivalasztott helyre.)

You are not connected to the network drive where the database is located. If the database is
located on a network drive, the network may occasionally experience problems that prevent
you from accessing the drive. Contact your computer support department for help in
reconnecting to the network drive where the database is located. (Nem kapcsolddik az
adatbazisnak helyet adé halézati meghajtéhoz. Ha az adatbazis egy halézati meghajton
talalhato, eléfordulhat, hogy idénként problémak Iépnek fel a haldzattal kapcsolatban,
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melyek megakadalyozzak a meghajtd elérését. Az adatbazist tartalmazé haldzati

meghajtéhoz vald ismételt csatlakozashoz kérje az informatikai tdmogatasi részleg

segitségét.)

Elfelejtette a rendelé CareLink Pro szoftverhez haszndlt jelszavat

Ha senki sem emlékszik a rendel6 altal a Carelink Pro szoftverbe val6 bejelentkezéshez

hasznalt jelszéra, ujra kell telepiteni a CareLink Pro szoftvert, és létre kell hozni egy Uj

adatbazist. A szoftver Ujratelepitését kovetéen nem érhetdk el a kordbbi adatbazisban

taldlhato betegadatok. Az Uj telepités sordn létrehozott jelszot helyezze biztonsdgos helyre

valahol az iroddban, hogy a jovében ne veszitsen el adatokat.

Készilékleolvasasi hibak

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is available, or select another port. (A
kivalasztott soros portot nem lehetett megnyitni.
El6fordulhat, hogy egy masik muvelet folyamatban van a
porton. Varjon, amig a port elérhetévé valik, vagy
valasszon egy masik portot.)

Gy6z6djon meg arrdl, hogy a kivalasztott
kommunikécidés portot nem hasznélja egy masik
program, vagy valasszon egy masik portot.
Prébélkozzon a szamitdgép ujrainditasaval, majd a
készulék ismételt leolvasasaval. El6fordulhat, hogy a
porthoz csatlakoztatott hardvereszkdz (kabel stb.)
vagy maga a port meghibasodott. A probléma
meghatarozasahoz csatlakoztassa a hardvereszkdzt
egy masik porthoz, és kisérelje meg Ujra a készulék
leolvasasat.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial port. (Az
automatikus észlelési szolgaltatds egyik elérhet6é porton
sem észlelte a késziiléket. Ellendrizze a
kabelkapcsolatot, valamint a késziilék telepét és
allapotat, majd prébélkozzon ujra, vagy adjon meg egy
soros portot.)

Ellendrizze a kabel és a szamitégép kozotti
kapcsolatot, és gy6zédjon meg arrél, hogy a
készllék telepének toltottsége megfelels. Ha igen,
az automatikus észlelés valasztasa helyett adja meg
a szamitégép azon soros portjat, amelyhez a kabel
csatlakozik.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Az eszkdéz nem talalhaté a
kivalasztott soros porton. Ellenérizze a kdbelkapcsolatot,
valamint a késziilék telepét és dllapotat. Ezutan
prébalkozzon Ujra, valasszon egy masik portot, vagy
probalja automatikus észleléssel megkeresni a
készuléket.)

Ellenérizze a kadbel és a szamitogép kozotti
kapcsolatot, és gy6zédjon meg arrél, hogy a
készulék telepének toltottsége megfelel. Ha igen,
valasszon egy masik soros portot a szamitégépen,
vagy valassza az automatikus észlelést.

Unable to communicate with the device. Please ensure
you've attached and selected the correct device, check
the cable connection, device battery and status, and try
again. (Nem lehet kommunikalni a készulékkel.
Gy6z6djon meg arrdl, hogy a megfeleld készllék van
csatlakoztatva, illetve kivalasztva, ellendrizze a
kabelkapcsolatot, valamint a késziilék telepét és
allapotat, majd prébélkozzon ujra.)

Ellendrizze a készilékleolvasashoz kivélasztott
beallitdsokat, koztiik a késziilék nevét, a
sorozatszamot és a kapcsolat tipusat. Gy6zédjon
meg arrdl is, hogy a késziilék, a kdbel és a
szamitogép megfeleléen csatlakozik egymashoz.
Ellenérizze, hogy megfelel6-e a késziilék
teleptoltottsége és riasztasi allapota. Kisérelje meg
Ujra a leolvasast.

Unexpected response... retrying (n%) (Varatlan valasz...
Ujraprobalkozéas (n%))

Nem a vart érték lett beolvasva a készulékrdl. A
rendszer visszavonasig vagy a sikeres
kommunikacio létrejottéig folyamatosan Ujra
megkisérli a kommunikaciot.
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The link device was found, but the device
(<sorozatszam>) is not responding. Please verify the
device’s serial number, place the device closer to the
link device to minimize signal interference, check device
battery and status. (A rendszer megtalalta az
Osszekottetési eszkozt, de a készillék (sorozatszam) nem
valaszol. Ellenérizze a késziilék sorozatszamat, az
interferencia minimalizalasa érdekében helyezze a
késziiléket minél kozelebb az 6sszekottetési eszkozhoz,
valamint ellenérizze a késziilék telepét és allapotat.)

Ellenérizze, hogy helyesen van-e megadva a
sorozatszdm. Ha nem, adja meg a helyes
sorozatszamot. Ha helyes sorozatszam van
megadva, prébalkozzon azzal, hogy kdzelebb
helyezi az 6sszekottetési eszkozt a kommunikécios
eszkdzhoz. Helyezze az &sszekottetési eszkdzt és a
kommunikécids eszkézt minél tdvolabb az esetleges
interferenciaforrasoktdl (példaul mas
radidfrekvencias készilékektdl). Ellendrizze a telep
toltottségét, valamint inzulinpumpa adatainak
feltoltése esetén a pumpa leadasi allapotat is.

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again. (Ez a pumpa éppen egy ideiglenes bazis
beaddsat hajtja végre. Vonja vissza az ideiglenes bazist,
vagy varja meg, amig az befejezédik, és probalkozzon
Ujra.)

Az olvasni kivadnt pumpa éppen egy ideiglenes
bazis beaddsat hajtja végre. Varja meg, amig az
ideiglenes bazis befejezédik, vagy vonja vissza az
ideiglenes bazist, és olvassa le a pumpat.

This device has active errors or alarms. Please clear the
alarms and try again. (A késziilékhez aktiv hibak vagy
riasztasok kapcsolddnak. Torélje a riasztdsokat, majd
prébalkozzon ujra.)

A pumpdhoz aktiv riasztasok tartoznak, melyek
megakadalyozzdk a pumpa leolvasasat. A riasztasok
torléséhez olvassa el a riasztasokra vonatkozé
utasitasokat. Torolje a riasztasokat, majd kisérelje
meg ismét a pumpa leolvasésat.

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again. (Ez a
pumpa éppen egy bolus beadasat hajtja végre. Vonja
vissza a bolust, vagy varja meg, amig az befejezédik, és
probalkozzon ujra.)

Az olvasni kivant pumpa éppen egy bolus beaddsat
hajtja végre. Varja meg, amig a bolus befejezddik,
vagy vonja vissza a bolust, és olvassa le a pumpat.

The device returned invalid entries; all data read will be
discarded. (A késziilék érvénytelen bejegyzéseket adott
vissza; a rendszer az 0sszes leolvasott adatot elveti.)

Kérje a helyi orszagos képviselet segitségét (lasd:
Tdmogatds 2. oldal).

Jelentés-létrehozasi hibak

Tobb adatbejegyzés tartozik ugyanahhoz a datumhoz

Ha ugyanazon késziilék esetében ugyanahhoz a ddtumhoz és idéponthoz tobb adatbejegyzés

tartozik, a rendszer ezt feloldhatatlan Utkozésnek érzékeli. Az ezekkel a késztilékadatokkal

létrehozott jelentésekben nem fognak szerepelni az egymassal atfedésben Iévé adatok.

Probélkozhat a jelentési id6szak moédositasaval oly médon, hogy az ne tartalmazza az

atfedésben lévé adatokat. Vagy azt is megteheti, hogy a kordbban mért adatok torlése

céljabdl a késziiléket torli a rendszerbdl, majd ismét hozzaadja.

A rendszer figyelmen kiviil hagy bizonyos adatokat

Ha a készllékidé megvaltoztatasa legaldbb haromérds iddtartamra vonatkozé adathalmazban

atfedést vagy hianyt okoz, a rendszer az érintett adatokat kihagyja a jelentések készitésekor.
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Biztonsagi mentéssel és visszaallitassal kapcsolatos hibak

Az adatbazis nem zarolhato

Ez akkor fordul el6, ha tobbfelhasznalds kdrnyezetben haszndlja a rendszert, és mas
felhasznaldk is be vannak jelentkezve. A rendszer nem engedélyezi az adatbazis biztonsagi
mentését, mikdzben mas felhasznaldk esetleg az adatbazist befolydsold feladatokat hajtanak
végre. Ha az dsszes felhasznald kilépett a CarelLink Pro alkalmazasbol, végrehajthatja az
adatbazis biztonsagi mentését.

Nem hajthaté végre az adatbazis biztonsagi mentése vagy visszaallitasa

Mas felhasznaldk nem tudnak bejelentkezni, és nem lehet biztonsadgi mentést vagy
visszaallitast végrehajtani. Kérje a helyi orszagos képviselet segitségét (lasd: Tdmogatds
2. oldal).

Nem sikeriil az adatbazis visszaallitasa

Az adatbazisrol készilt azon biztonsdgi masolat fajlja, amelyet a visszaallitasi eljaras soran
hasznalni kivan, sérilt. A visszadllitast kisérelje meg egy masik biztonsagimasolat-fajllal
végrehajtani.

A szoftver eltavolitasa

Ha a CareLink Pro eltdvolitasara van szliikség, hajtsa végre az alabbi Iépéseket:
1 Nyissa meg a Vezérlépultot a Windows Start menujébdl.

2 Valassza a Programok telepitése és torlése lehetéséget. Ekkor megnyilik a Windows
Programok telepitése és torlése segédprogramja.

3 Gorgessen lefelé, és jelolje ki a Medtronic CareLink Pro elemet.
4 Kattintson az Eltavolitas gombra. Ekkor megjelenik a telepitévarazslo.

5 Kattintson a Next (Tovabb) gombra. Ekkor megjelenik egy lizenet, amely az alkalmazas
eltavolitasanak a megerdsitésére kéri.

6 Kattintson a Yes (Igen) gombra. Az eltavolitdoprogram torli az alkalmazast és az ahhoz tartozé
0sszes fajlt a szamitogéproél. A mlvelet befejez6désekor a varadzsld egy lizenetben tajékoztat
az eltavolitas végrehajtasarol.

7 Kattintson a Finish (Befejezés) gombra.

CareLink Pro Hasznalati utmutatd ~ Hibaelharitas 54



lkontablazat

A csomagolds cimkéin és a késziiléken évé ikonok és szimbdélumok magyarazata a kdvetkezd

tablazatban lathato:

Dobozonként/csomagonként egy

Figyelem! Olvassa el a haszndlati utasitasban talalhato f
figyelmeztetéseket és elirdsokat.

Kataldgusszam REF
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CSV-adatok

A jelentésadatok a CareLink Pro alkalmazasbdl valé exportalasukkor egy .csv fajlba keriilnek.

Ez a fajl azutdn szdmolotabla-alkalmazasokba, példaul a Microsoft Excel programba

importalhaté. A CSV-fajlok oszlopainak aldbbi leirdsdbdl megtudhatja, hogy milyen adatok

kerllhetnek be egy CSV-fjlba.

A CSV-ajl a beteg nevét és betegazonositdjat, a jelentési idészakot, valamint a jelentésbe

szerepl6 eszkdzok azonositasat tartalmazza.

Oszlopadatok jelentése

Index

Time (Idépont)

BG Reading (mg/dL vagy mmol/L) (VC-érték - mg/dl
vagy mmol/l)

Basal Rate (U/h) (Bazisitem - E/6)

Temp Basal Type (Ideiglenes bazis tipusa)

Az adatok késziilékben tortént rogzitésének
sorrendje.

Az adatok késziilékben tortént rogzitésének
idépontja.

A méréeszkdz, Guardian vagy pumpa éltal mért
vércukorszintérték. Ha az adatok pumpébdl vagy
Guardian késziilékbdl erednek, az oszlopban a kézi
és a Link méréeszkdzbél szarmazé
vércukorszintértékek lathatok.

Az aktiv bazisinzulin adagolasi Giteme érankénti
egységszamban.

Az ideiglenes bazis bedllitdsdnak tipusa (inzulinitem
vagy a bazis szazaléka).
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Bolus Type (Bolus tipusa)

A bolusinzulin adagolasi tipusa [Normal — Normdl,
Square - Négyszdg, Dual (normal part) - Kéthulldmu
(normdl rész) vagy Dual (square part) — Kéthullamu
(négyszoghulldmu rész)].

Bolus Volume Delivered (U) (Beadott bolusmennyiség —
E)

Prime Type (Feltoltés tipusa)

Alarm (Riasztas)

Rewind (Visszatekerés)

BWZ Target High BG (mg/dL vagy mmol/L) (BWZ - VC
fels6 célértéke — mg/dl vagy mmol/l)

BWZ Carb Ratio (BWZ - szénhidratarany)

BWZ Carb Input (BWZ - szénhidrat megaddsa)

BWZ Correction Estimate (U) (BWZ - korrekcids becslés
- F)

BWZ Active Insulin (U) (BWZ - aktiv inzulin - E)

A bolusinzulin-adagolaskor ténylegesen beadott
inzulinegységek szama.

Kézi vagy rogzitett. A kézi feltdltés kozvetlenil
visszatekerés utan torténik az infuzids szerelék
csovének inzulinnal valé feltoltéséhez annak
bekotése eldtt. A rogzitett feltdltés az infuzids
szerelék bekdtése utdn torténik a puha kanil
inzulinnal valé feltoltése érdekében, a bevezet6tl
kivétele utan.

A tortént riasztas neve.
A késziilék visszatekerésének datuma és ideje.

A vércukor céltartomanyanak felsé értéke, a Bolus
Wizard szolgaltatds haszndlja.

Az inzulin-szénhidrat arany értéke. Ha az egység a
gramm, akkor az arany azt jelenti, hogy hany gramm
szénhidratot kompenzal egy egységnyi inzulin. Ha az
egység a csere, akkor az arany azt jelenti, hogy hény
egységnyi inzulin hasznalatos egy csereegység
szénhidrat kompenzéldsahoz.

A Bolus Wizard szolgaltatasban megadott, illetve a
bolusbecsléshez haszndlt szénhidratmennyiség.

A vércukorszint korrigalasa érdekében beadandé
bolusinzulin egységszama a Bolus Wizard szémitdsa
szerint.

A korabbi bolusinzulin-adagoldsokbdl az aktiv inzulin
testben maradé mennyiségének szamitott értéke, ha
a becsiilt bolusmennyiség meghatarozésa a Bolus
Wizard szolgaltatdssal torténik.
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Sensor Glucose (mg/dL vagy mmol/L) (Szenzor

glikézértéke — mg/dl vagy mmol/l) A szenzor altal mért glikozérték.

A szenzorrdl leolvasott, nanoamperben (nA) mért

ISIG value (ISIG érték) bemens jelek (ISIG).

Tovabbi tudnival6ok a CareLink Pro altal exportalt CSV-fajlokrél

A CSV-fdjl tetején lathatd cim a kovetkezOket tartalmazza:

+ a beteg neve

« a kivalasztott késziilékek és sorozatszamaik listaja

« a kivalasztott ddtumtartomany

Az egyes oszlopblokkoknak is van cime, amely a kovetkezéket tartalmazza:
« azon eszkdz neve, amelyre az adatok vonatkoznak

. ezen eszkoz sorozatszama

Ha az adatok nem a vart médon jelennek meg
Tobb tényezd is szerepet jatszhat abban, ha a CSV-adatok a varttdl eltéréen jelennek meg.

« Az eszkoz datumanak és idejének valtozasa hatdsara mdédosulhat a sorrend, illetve a kijel6lt
datumtartomdanyon kivili adatok is megjelenhetnek.

« Ha hosszu idé6 telik el a késziilékleolvasasok kozott, akkor a készUilékre vonatkozo adatok tobb
blokkban jelenhetnek meg.
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Szoszedet

A1C - Glikozilalt hemoglobin

A1C mérése - A hemoglobin A1C mérése, amellyel egy idészakra vonatkozdan kovethetd a
vércukorszint.

alacsony gliikoz - A pumpa figyelmeztet, ha a szenzor észlelése szerint a felhasznalé glikdzszintje
erre az értékre vagy ez ald csokken. Ez a funkcié engedélyezhetd vagy letilthato.

alacsony tartalyszint jelzése - Programozhato jelzés, amely értesiti, ha mar csak adott szamu egység
van a pumpa tartalydban, illetve ha mér csak adott idétartam van hatra a tartaly kitruléséig.

atlagos abszolut eltérés % (MAD%) - A szenzor vércukorméré-eszkozhoz torténd kalibraldsanak
pontossagi szintjét adja meg. Minél kisebb ez a szdm, annal pontosabb a kalibralas. Az MAD%
kiszdamitadsahoz az egymashoz kozeli szenzor-gliik6zértékek és a vércukorméré-eszkdzzel mért
értékek paronkénti kiilonbségét veszik, ezt elosztjdk a méréeszkdzos mérés eredményével, majd
atlagot szamitanak az 6sszes parra.

bazisinzulin - Orankénti, folyamatosan adagolt inzulin, amelyet az inzulinpumpa automatikusan ad
be a pumpan bedllitott elére programozott profilok és személyre szabott Gitemek alapjan. A
pumpa adagol egy napi inzulinmennyiséget, amely altaldban fedezi a hattérinzulinszintet az
étkezésmentes id6szakokra (példaul éjszakara és az étkezések kdzott).

bazisprofil - Kezd6- és zaréidéponttal rendelkezd bazistiitem. A felhasznélé egy 24 éras id6szakra
tobb kiilonb6zé profilt programozhat be a pumpan eltérd bazisitemekkel a jobb vércukorszint-
szabdlyozas érdekében.

bazissémak - A felhasznalé legfeljebb harom kiilonb6zé bazisiitemsémat programozhat be a
pumpan a bazisinzulin beaddsdhoz: Standard (Normal), A és B. Az egyes sémakhoz legfeljebb 48
bazistitem allithato be.

bazisiitem - A pumpa azon beallitadsa, mely folyamatos inzulininfiziét tart fenn, ezaltal stabilan tartja
a vércukrot az étkezések kozott és éjszaka. A bazisinzulin a hasnydlmirigy inzulintermelését
utdnozza, igy fedezi a szervezet nem taplalékhoz kotott inzulinsziikségletét.

bolusinzulin - Egy adag inzulin, mely a varhat6 (példaul étkezés utani) vércukor-emelkedést
kompenzalja, vagy a céltartomanyba csokkenti a magas vércukorértéket.

CareLink’ Personal - Online szolgaltatas, amely lehet6vé teszi a diabéteszadatok kezelését az
interneten.

CH - Szénhidrat

CH-arany (szénhidratarany) - Aza szénhidratmennyiség, amelyet egy egységnyiinzulin kompenzal.
(Lasd még: cserearany.)

CH-egység- Ataplalékbevitel a Bolus Wizard hasznalatakor. Megadhaté (szénhidrat)grammban vagy
csereegységben.
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ComLink - Radiofrekvencias ado-vevo késziilék, amellyel a Paradigm pumpa adatai let6ltheték a
szamitégépre.

Com-Station - Olyan eszkdz, amellyel a MiniMed 508 pumpa és a kiilsé cégek altal gyartott
méréeszkdzok atmend adatai letdltheték a szamitdgépre.

csatlakozas

(1) A méréopcio bekapcsolasa és beallitdsa ahhoz, hogy a pumpa fogadja a pumpaval
kommunikalé méréeszkoz altal mért vércukoreredményeket.

(2)

cserearany - Az az inzulinmennyiség, amely egy (1) csereegység szénhidrat kompenzalasahoz
szlikséges. (Lasd még: CH-arany.)

Dual Wave® bolus - (Kéthullamu bolus) Az azonnal adagolt normal bolus és az azt kéveté Square
Wave (négyszoghulldamu) bolus kombinacidja. A négyszoghullamu rész adagoldsa adott
idétartamon belil egyenletes.

Easy Bolus™ - (Egyszer( bolus) A normal bolus beadasanak médja az Easy Bolus gomb
megnyomasaval a pumpan.

expressz bolus - Barmely tipusu bolus beadasanak médja a pumpa Express bolus gombjanak
megnyomasaval.

étkezési bolus - Az az inzulinadag, amely kompenzalja az étkezések utan varhatéan bekodvetkezé
vércukor-emelkedést.

felfiiggesztés - A pumpa azon funkcidja, amely minden inzulinadagolast leallit. Minden aktualis
bolusbeadds és/vagy feltdltés megszakad. A bazis adagolasa Gjrainditasig sziinetel.

feltoltés - A pumpa vagy méréeszkdz adatainak atvitele a CareLink® Personal kiszolgaléra.

gorbe alatti teriilet (AUC) - A felfelé és lefelé torténé kilengések mennyiségét jelzi az elére bedllitott
értékek alapjan. A kilengésadatok a felsé és also értékek gyakorisagat jelzik. A gorbe alatti terilet
az események mértékét jelzi gy, hogy megmutatja, milyen mértékben és mennyi ideig keriilnek
ki az értékek a tartomanybdél.

hangjelzéses bolus - A pumpa beprogramozhaté ugy, hogy a felhasznalé csipogast halljon egy
beadandd bolusinzulin-mennyiség (0,5 vagy 1,0 egység) kivalasztasakor. Ez olyan helyzetekben
hasznos, amikor a pumpa gombjai nem lathatok jél.

HbA1c - Glikozilalt hemoglobin

HbA1c mérése - A hemoglobin ATC mérése, amellyel a vércukor-szabdlyozas vagy a szintek atlaga
mérhetd egy 2-3 honapos idészakra vonatkozéan.

hiperglikémia - Megemelkedett vércukorszint, amely vércukorszintméréssel mutathaté ki, és a
kodvetkezd tlinetek kisérhetik: hanyinger, hanyds, homalyos latas, fejfdjas, gyomorbantalmak,
gyakori és nagy mennyiség vizeleturités, valamint levertség.

hipoglikémia - Alacsony vércukorszint, amely vércukorszintméréssel mutathato ki, és a kovetkezd
tlinetek kisérhetik: tulzott éhség, remegés vagy reszketés, izzadas, ,tdncold” 1atas, szédulés,
fejfajas, zavaros beszéd, hirtelen hangulatvaltasok, valamint személyiségvaltozas.

ideiglenes - Atmeneti

ideiglenes bazis - Ideiglenes, egyszeri bazisinzulin megadott adagban és id6tartamig. A specialis,
nem mindennapos tevékenységekkel vagy allapotokkal jaré inzulinsziikségletet elégiti ki.

inflizids szerelék - Olyan eszkoz, amellyel a kaniil beilleszthet6 és rogzithetd a bor alatt, valamint az
inzulin csdveken at a pumpabdl a bevezetési helyre tovabbithato.

inzulinérzékenység - Az az érték (mg/dl-ben vagy mmol/I-ben), mellyel a vércukorszint (VC) egy
egységnyi inzulin hatasara csokken. (A Bolus Wizard adata.)

inzulinkoncentracio - Az orvos altal a felhasznalo szamara el6irt er6sségU vagy tipusu inzulin. Ez
hatdssal van a pumpa altal beadott inzulin Gitemére. Ha a felhasznald inzulinkoncentraciéja
valtozik, a bazissémakat, valamint a maximalis bazis- és bolusiitemeket Ujra kell programozni a
pumpan.
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ISIG - Szenzorértékek, amelyek azt jelzik, hogy egy szenzorral felszerelt rendszerben a tdvadd
elektronikaja megfeleléen mikodik-e. Amennyiben az ISIG értéke kisebb, mint 24,00 nA vagy
nagyobb, mint 29,00 nA, kérjen terméktamogatast. Lehet, hogy ki kell cserélni a tavadot.

kalibralasra valé figyelmeztetés - A pumpa 12 éranként automatikusan elinditja a Meter BG By
00:pp (VC mérése legkésébb ekkor: 66:pp) figyelmeztetést, jelezve, hogy a jelenlegi kalibracios
érték érvényét vesztette. A kalibralasi figyelmeztetés értékeként az az id6 jelenik meg, amely az
aktualis kalibralasi érték lejartaig hatra van (a felhasznald beallitasa alapjan). Ha példaul a
kalibralasi figyelmeztetés értéke 2 6rara van allitva, a vércukormérésre figyelmeztetd jelzés 2
o6raval a kalibracié tervezett idépontja el6tt aktivalodik.

ketonellendrzés - A keton olyan melléktermék, amely akkor jon létre, ha a szervezet arra kényszerdil,
hogy cukor helyett zsirt égessen az energianyeréshez. Ez jelezhet inzulinhidnyt a szervezetben. A
ketonellen6rzés a vérben vagy a vizeletben méri a ketonkoncentraciét.

kézi bolus - (Manual Bolus) A Bolus menti egyik valaszthaté eleme, ha a Bolus Wizard szolgaltatas
aktiv. A bolusprogramozas egyik, a Bolus Wizard hasznalata nélkuli médja.

korrekcios bolus - Az az inzulinmennyiség, amely a magas vércukorszint céltartomanyba val6
csokkentéséhez sziikséges.

korrekcios tényezé - Az a mennyiség, amellyel a vércukor 1,0 egység inzulin hatasara csékken. Ez a
tényez6 hasznalhaté a korrekcids bolus mennyiségének kiszamitasara, ha magas a vércukorszint.
(VC-szint) - (VC-célérték) = X. X + (korrekcids tényezd) = korrekcioés bolus mennyisége

lépés - Az inzulin mértékegysége, melyet az Easy Bolus szolgaltatassal torténd beadashoz lehet
bedllitani és hasznalni.

magas glitkoz - A pumpa figyelmeztet, ha a szenzor észlelése szerint a felhasznalo gliikozszintje eléri
vagy tullépi ezt az értéket. Ez a funkcié engedélyezhetd vagy letilthato.

maximalis bazisinzulin - Az a maximalis mennyiség( bazisinzulin, amelyet a pumpa egyszerre ad
le. (Az értéket a felhasznald dllitja be.)

maximalis bolus - Az a maximalis mennyiség( bolusinzulin, amelyet a pumpa egyszerre ad le. (Az
értéket a felhasznalé allitja be.)

mérdeszkoz - Olyan orvosi eszkdz, amellyel megkozelitéleg meghatarozhaté a vércukor
koncentracidja. A vizsgélathoz vércseppet helyeznek egy egyszerhasznalatos tesztszalagra,
amelyet a méréeszkdz leolvas, majd ez alapjan kiszamitja a vércukorszintet. A méréeszkz mg/dI-
ben vagy mmol/l-ben adja meg a szintet.

mérdéopcio - Olyan szolgaltatas, amellyel engedélyezhetd, hogy a pumpafogadja egy csatlakoztatott
vércukormérd eszkoz altal mért vércukorértékeket.

négyszoghullamurész- (Sq) A kéthulldmu bolus masodik része. A négyszoghulldmu rész adagolasa
az azonnali adagrész beaddsa utan, egyenletesen, adott ideig torténik.

normal bolus - Adott egységnyi inzulin azonnali beadasa.

normal séma - A normal bazis a szokasos napi tevékenységekhez. Ha a sémaszolgaltatas ki van
kapcsolva, a pumpa a normal sémat hasznalja.

RF - Radiofrekvencias

sémaszolgaltatas - A pumpa funkcidit bévité szolgaltatas, mellyel opcionalis bazisok (A séma, B
séma) programozhatok be. Ezek azon tevékenységeket vagy vércukorsémakat tamogatjak,
melyek a napi rutinnak nem részei, de rendszeresek. llyen példaul a heti egyszeri sportolas, az
alvasi szokasok valtozasa a hétvégén vagy a menstrudcios ciklus alatti hormonalis valtozasok.

Square Wave® bolus - (Szégletes hulldmu bolus) Egyenletesen, adott ideig (30 perc-8 éra) adagolt
bolus.

tavado azonositdja - Az éppen hasznalatban l1évé tavado sorozatszama.

VC - A vércukor roviditése
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